


Access Information Window
Allows you to specify access information for the servers in the managed domain.
NetWare for SAA Services Manager automatically opens the Access Information window 
for a NetWare for SAA server the first time you add the server to the managed domain. 
After that, NetWare for SAA Services Manager opens the Access Information window for a
NetWare for SAA server only if you did not save the user name and password you 
previously specified.

Related Topics
Adding Servers
Changed Managed Domain Window 
Redefining the Managed Domain



User Name
Allows you to specify a user name. A NetWare system administrator must have assigned 
supervisor-equivalent privileges or file server console operator privileges to the name 
you specify. If the specified name has supervisor equivalency, you can use NetWare for 
SAA Services Manager to obtain server information and control NetWare for SAA servers 
and their resources. If the name has file server console operator privileges, you can use 
NetWare for SAA Services Manager to obtain server information, but you cannot use it to 
control servers or their resources.



Password
Allows you to specify a password if the NetWare system administrator assigned one to 
the user name specified in the User Name text box.



Save User Name and Password check box
Select this check box to save the specified user name and password so NetWare for SAA 
Services Manager can use that information the next time you access the same NetWare 
for SAA server.



OK button
Closes the Access Information window with the specified settings and causes NetWare for
SAA Services Manager to attempt to log into the NetWare for SAA server.



Cancel button
Closes the Access Information window and returns you to the Active Domain window.    
The server associated with the Access Information window is removed from the managed
domain.



Active Domain Window
Displays server icons or server names for the NetWare for SAA servers included in the 
active domain. You use this window to specify on which server NetWare for SAA Services 
Manager is to perform an operation.
You cannot close this window while running NetWare for SAA Services Manager.

Related Topics
About the Managed and Active Domains 
Arrange Icons Command 
Viewing Servers by Icon 
Viewing Servers by Name 



Change Managed Domain Icon
Opens the Change Managed Domain window.



Users Icon
Opens the User Information window.



Server Status Icon
Opens the Server Status window.



Server Management Icon
Opens the Server Management Options window.



View by Icon Icon
Displays server icons in the Active Domain window.



View by Name Icon
Displays server names in the Active Domain window.



Server Icons
Represents the servers currently in the active domain.    Select a server icon and then 
click an icon in the Tool Bar to access NetWare for SAA Services Manager server 
functions. You can also double-click a server name or icon to open the Server Status 
window.



Adapter Configuration Window
Displays configuration data for adapters shown in the Server Status window. To access 
this window, either select an adapter and click the More Information icon or double-click 
an adapter. 

Related Topics
Adapter Configuration Data 



Media Type
Identifies the type of connection for the adapter.



MAC Address
Media access control address of a LAN station. This is not applicable to SDLC or channel 
adapters.



Adapter Slot
Number of the slot in which the board is installed. This does not apply to Bus-Tech remote
channel adapters.



First I/O Address
Absolute primary base I/O port for the adapter. This does not apply to Bus-Tech remote 
channel adapters.



First Memory Address
Absolute primary memory address for the adapter. This does not apply to Bus-Tech 
remote channel adapters.



MLID Version
Major and minor version numbers of the Multiple Link Interface Driver (MLID).



Second I/O Address
Absolute secondary base I/O port for the adapter. This does not apply to Bus-Tech 
channel adapters.



Card Name
Name assigned to the LAN adapter by its manufacturer.



Second Memory Address
Absolute secondary memory address for the adapter. This does not apply to Bus-Tech 
remote channel adapters.



First Interrupt Line
Primary interrupt vector number. This does not apply to Bus-Tech remote channel 
adapters.



Link Speed
Link speed the adapter supports. MSB=1 indicates Kbps; MSB=0 indicates Mbps.



Audit Trail Detailed Information Window
Displays details about a record in the audit trail log file. 

Related Topics
Accessing Audit Trail Log Files
Audit Trail Window



Entry Time
Indicates the date and time the listed action was performed.



Network Address
Identifies the network address of the user.



Action
Indicates the type of action performed. Possible values are BIND, CONNECT, 
DISCONNECT, GENERIC, LOGIN, LOGOUT, and UNBIND.



Product ID
Indicates the application used at the time the connection is established. If the action is 
not CONNECT or DISCONNECT, this field does not appear.



Profile
If the action indicates a LOGIN, this identifies the NetWare for SAA service profile used. If 
the action is other than LOGIN, this field does not appear.



User ID
Identifies the user's login name.



LU
Identifies the logical unit (LU) used.



Application Name
Identifies the application used at the time of the listed action. If the action is other than 
BIND, this field does not appear.



Audit Trail Window
Provides access to a NetWare for SAA server's audit trail log file.

Related Topics
Accessing Audit Trail Log Files
Audit Trail Detailed Information Window 
Server Management Options Window



First Page Icon
Scrolls to the first page of available information.



Previous Page Icon
Scrolls to the previous page of available information.



Next Page Icon
Scrolls to the next page of available information.



Last Page Icon
Scrolls to the last page of available information.



More Information Icon
Opens the Audit Trail Detailed Information window for the selected record.



Entry Time
Indicates the date and time the listed action was performed.



User ID
Identifies the user's login name.



Network Address
Identifies the network address of the user.



Action
Indicates the type of action performed. Possible values are BIND, CONNECT, 
DISCONNECT, GENERIC, LOGIN, LOGOUT, and UNBIND.



Profile
Identifies the NetWare for SAA service profile used.



LU
Identifies the logical unit (LU) used.



Application ID
Identifies the application used at the time of the listed action.



Change Managed Domain Window
Displays a list of the available communication servers and allows you to specify which 
servers are included in the managed domain.

Related Topics
Adding Servers
Redefining the Managed Domain 
Removing Servers



Delete Icon
Removes the selected server(s) from the current list box.



 Add Icon
Adds the selected server(s) to a list box.



OK Icon
Closes the current window and applies the specified settings.



Server Name text box
Allows you to specify the name of a server to be added to the managed domain. The 
server does not have to be currently available.    When an unavailable server added to 
the managed domain becomes available, it will be added to the active domain.



Managed Domain list box
Lists the NetWare for SAA servers included in the managed domain.



Available Comm. Servers list box
Lists the NetWare for SAA servers connected to the network. This list is obtained when 
the Change Managed Domain window is opened or when an active server in the 
managed domain becomes inactive and the time RECONNECTDELAY parameter expires.



Save Domain List to Disk check box
Specifies whether the specified managed domain is saved so that it is used the next time
NetWare for SAA Services Manager is started.



Detailed Information Windows
NetWare for SAA Services Manager allows you to access several Detailed Information 
windows. Access these windows by either double-clicking a record or logical unit (LU) 
name or selecting a record or LU name and clicking the More Information icon.
Audit Trail Detailed Information Window 
Event Record Detailed Information Window 
LU 6.2 Detailed Information Window 
SNA Session Detailed Information Window 



NWSAA Services Manager Application Window
This window is automatically opened when you start NetWare for SAA Services Manager.

Related Topics
Access Information Window 
Active Domain Window 
Arrange Icons Command 
NetWare for SAA Services Manager Menus 
Event Monitor Window 



File Menu
Accesses the Output command (<Alt+F+O>) and the Exit command (<Alt+F+X>).



Edit Menu
Accesses the Copy command (<Alt+E+C>).



Fault Menu
Accesses the Event Monitor command (<Alt+A+E>).



Window Menu
Accesses the Cascade command (<Alt+W+C>), the Tile command (<Alt+W+T>), the 
Arrange Icons command (<Alt+W+A>), and the Close All command (<Alt+W+L>).    This
menu also lists the names of any open windows.



Help Menu
Access the following help commands:

Index command        
(<Alt+H+I>)

Alarms command 
(<Alt+H+L>)

Commands command 
(<Alt+H+C>)

Glossary command 
(<Alt+H+G>)

Overview command 
(<Alt+H+O>)

Procedures command 
(<Alt+H+P>)

Using Help command 
(<Alt+H+U>)

About NetWare for SAA 
Services Manager command 
(<Alt+H+A>)



Change Managed Domain icon
Opens the Change Managed Domain window.



Users icon
Opens the User Information window.



Server Status icon
Opens the Server Status window.



Server Management icon
Opens the Server Management Options window.



View by Icon icon
Displays server icons in the Active Domain window.



View by Name icon
Displays server names in the Active Domain window.



Server icons
Server icons for the servers currently in the active domain. Select a server icon and click 
an icon to access NetWare for SAA Services Manager server functions. You can also 
double-click a server icon to access the Server Status window.



Active Domain Message Bar
List the messages associated with any actions performed in the Active Domain window.



Event Log icon
Opens the Event Log file containing the selected event message.



Remove Event icon
Deletes the selected event from the Event Monitor list box.



More Information icon
Opens a Detailed Information window for the selected object.



Customize Event icon
Opens the Customize Events window.



Stop Scroll Check Box
Toggles the scrolling of event messages in the Event Monitor list box.



Critical Lock Check Box
Toggles the critical lock setting. The critical lock controls how NetWare for SAA Services 
Manager deletes event messages when the Event list box is full of only critical messages.



Servers
Identifies the NetWare for SAA server on which the event occurred.



Severity
Indicates the event severity level.



Date
Indicates the date the event occurred. This date is the date from the NetWare for SAA 
Services Manager workstation.



Time
Indicates the time the event occurred. This time is the time from the NetWare for SAA 
Services Manager workstation.



Source
Identifies the managed object that detected or generated the event.



Description
Describes the cause of the event.



Event Monitor Message Bar
Displays messages associated with actions performed in the Event Monitor window.



Customize Events Window
Allows you to specify how NetWare for SAA Services Manager notifies you of network 
events.

Related Topics
Customizing the Displaying and Notification of Events 
Displaying Event Messages in Color 
Displaying Server Icons in Color 
Event Monitor Window 
Setting the Audible Alert 
Setting the Display Filter 
Specifying Number of Event Messages 



Ok Icon
Closes the current window and applies the specified settings.



Severity Levels
Lists the severity levels of event messages.



Display Check Boxes
Specifies the severity levels of the events for which NetWare for SAA Services Manager 
displays messages. This controls the display filter. 



Server Icon Color Check Boxes
Specifies whether server icons in the Active Domain window change color to match the 
severity levels of the events sent to NetWare for SAA Services Manager.



Audible Alert Check Boxes
Specifies which severity levels cause NetWare for SAA Services Manager to beep. 



Maximum Number of Local Events Text Box
Determines the maximum number of events NetWare for SAA Services Manager can 
monitor. The default is 64; the maximum is 500.



Display with Colors Check Box
Specifies whether NetWare for SAA Services Manager displays event messages in color 
to indicate the severity of the events.    The color indicates the most severe event 
message associated with a server.



Event Log Window
Provides access to the records of a NetWare for SAA server's event log file.

Related Topics
Accessing Event Log Files Through the Event Monitor Window 
Accessing Event Log Files Through the Server Management Options Window 
Accessing Additional Event Record Information
Event Monitor Window
Event Record Detailed Information Window 
Server Management Options Window 



First Page Icon
Scrolls to the first page of available event record information.



Previous Page Icon
Scrolls to the previous page of event records information.



Next Page Icon
Scrolls to the next page of event records information.



Last Page Icon
Scrolls to the last page of event record information.



More Information Icon
Opens the Event Record Detailed Information window and displays additional information
about an event record.



Source
Identifies which managed object detected the event.



Severity
Indicates the event's severity level.



Entry Time
Indicates the date and time the event occurred.    This information is based on the 
NetWare for SAA Services Manager workstation date and time.



Description
Provides a brief summary of the event.



Event Monitor Window
Provides access to network events. This allows you to clear event messages, to control 
the scrolling and discarding of event messages, and to open the Customize Events 
window and customize how NetWare for SAA Services Manager notifies you about 
network events.

Related Topics
About Severity Levels 
Accessing Event Log Files Through the Event Monitor Window 
Accessing Additional Event Record Information 
Clearing Event Messages 
Customize Events Window 
Customizing the Displaying and Notification of Events 
Event Log Window 
Event Record Detailed Information Window 
Processing of Network Events 
Setting the Critical Lock 
Severity Level Colors 
Turning Off Automatic Scrolling 



Event Log Icon
Opens the Event Log window and displays the event log for the selected event.



Remove Icon
Clears the selected event messages from the Event list box.



More Information Icon
Opens the Event Record Detailed Information window and displays additional information
about the selected event. 



Customize Icon
Opens the Customize Events window and allows you to customize how NetWare for SAA 
Services Manager notifies you about network events.



Critical Lock Check Box
Allows you to set the critical lock. The critical lock controls how NetWare for SAA Services
Manager discards event messages when the list box becomes full of only critical 
messages.



Stop Scroll Check Box
Controls the scrolling of events in the Event list box.



Servers
Identifies the NetWare for SAA server on which the event occurred.



Severity
Indicates the severity level of the event.



Date
Indicates the date the event occurred.    This date is based on the NetWare for SAA 
Services Manager workstation.



Time
Indicates the time the event occurred.    This time is based on the NetWare for SAA 
Services Manager workstation.



Source
Identifies the managed object that detected or generated the event.



Description
Provides a brief summary of the cause of the event.



Event Record Detailed Information Window
Displays additional information about an event message listed in either the Event Log 
window or the Event Monitor window.

Related Topics
Accessing Event Log Files Through the Event Monitor Window 
Accessing Event Log Files Through the Server Management Options Window 
Accessing Additional Event Record Information 
Event Log Window 
Event Monitor Window 



Server
Identifies the NetWare for SAA server on which the event occurred.



Severity
Indicates the event severity level.



Entry Time
Indicates the date and time the event occurred.    This is based on the date and time of 
the NetWare for SAA Services Manager.



Source
Identifies the managed object that detected the event.



Description
Provides a description of the cause of the event.



Remedial Action
Lists the recommended corrective action.    This appears only when a corrective action is 
applicable.



File Server
Identifies the name of the file server associated with the event.    This appears only when 
a file server name is applicable to the event.



For Further Assistance Contact Information
Displays information specified in the Miscellaneous Information field of CSCON's Server 
Description window.



Graph Settings Window
This window displays the available statistical attributes and graph setting options for the 
selected object.



OK Icon
Closes the current window and applies the specified settings to the Graph Statistics 
window.



Statistical Attributes
Lists the attributes available for the selected object or service component.



Profile
Lists groups of predefined attributes. This may not be available for every object.



Y-Range
Sets the range of values for the y axis to equal 100; 1,000; 10,000; or 100,000.



Style
Sets the counter style to the selected style of dashed line (---), dotted line (...), dashed 
dot line (-.-.-.), or dashed dotted dot line (-..-..-..).



Interval
Indicates the time in minutes between polling intervals.



Total Samples
Indicates the total number of intervals included in the graph. If the data received from 
the intervals exceeds what can be displayed in the graph, the data scrolls across the 
graph.



Reset Attribute Value Check Box
Determines whether attribute values are to be reset at the start of each interval.



Continuous Collecting Check Box
Allows continuous collecting of statistical data after the number specified in the total 
sample field is reached.



Graph Statistics Window
Displays the statistical data for the specified object according to the specified graph 
settings.



Graph Settings Icon
Closes the Graph Statistics window and returns you to the Graph Settings window.



Sample Interval
Indicates the amount of time specified for the interval in the Graph Settings window.



Total Samples
Displays the number of intervals included in the graph.



Time Polling
Indicates the total amount of time polling has been in effect.



Vertical Axis Scale
Toggles more detail for the y axis values.



Vertical Axis Scale
Toggles less detail for the y axis values.



Legend
Displays or hides the legend for the graph.



Number Format Button
Displays y axis data in numerical format.



Percentage Format Button
Displays y axis values in percentage format.



Horizontal Grid
Superimposes a horizontal grid on the display.



LU6.2 Sessions Detailed Information Window
This window displays additional information for a logical unit (LU) selected in the LU6.2 
Sessions window.

Related Topics
Displaying Session Information for LU6.2
LU6.2 Sessions Window



Selected LU
Identifies the logical unit (LU) ID of the selected LU.



Partner
Identifies the partner LU name.



DLC Type
Identifies the type of data link connection (DLC) between the NetWare for SAA server and
SNA node that houses the partner LU. Possible values are SDLC, QLLC, 802.2, CUSTOM, 
or ITRN (IBM Token Ring).



DestinationAddr
Identifies the partner's media access control (MAC) address.



Mode
Identifies the mode of the selected session.    A session can be in either SNASVCMG mode
or a user-defined mode. For details about the SNASVCMG mode, see your IBM LU6.2 
documentation.



ActSessions
Identifies how many sessions are active on the various nodes.



LU6.2 Sessions Window
Displays information about a NetWare for SAA server's LU6.2 sessions.

Related Topics
Displaying Session Information for LU6.2
LU6.2 Sessions Detailed Information Window



First Page Icon
Scrolls to the first page of    LU6.2 data.



Previous Page Icon
Scrolls to the previous page of LU6.2 data.



Next Page Icon
Scrolls to the next page of LU6.2 data.



Last Page Icon
Scrolls to the last page of LU6.2 data.



More Information Icon
Opens the LU6.2 Detailed Information window and displays additional information about 
an LU that has at least one partner LU and is listed in the LU6.2 Sessions window.



Update Icon
Updates the LU6.2 Sessions window with the most recent LU6.2 and session information.



ID
Indicates the LU's ID (valid for only dependent LUs).



Name
Identifies the LU's local name.



Status
Indicates the LU's current status (ATTACHED or DETACHED).



Number of Sessions
Indicates the number of active sessions.



SLimit
Indicates the maximum number of sessions. This value is set by the 
PARTNER_LU_SESSION_LIMIT parameter used by the ATTACH_LU verb in your transaction 
program.



Number of Partners
Indicates the current number of partners the LU has.



Output Window
Allows you to print or save data displayed in an active window.

Related Topics
Printing 
Saving Data to a File 
Saving Data to the Windows Clipboard 



Output To Options
Specifies if the data is to be output to the printer, the Micorsoft Windows clipboard., or a 
local file.



Output From Options
Specifies if the data is coming from the screen or the server's database. This option is 
available only when the Audit Trail window or Event Logs window is active.



File Name Text Box
Specifies the name of the file to which the data is to be saved.



Output Button
Prints or saves the data.



Cancel Button
Closes the Output window and returns to the current window, without saving changes.



Override Existing Connection Window
Allows you to specify whether you want to use a connection that is under a different user
name than the one specified in the Access Information window.

Related Topics
Access Information Window 
Overriding Existing Connections 
Retaining Previous Connections 



New User Button
Severs the previous connection to the NetWare server and then attempts to attach you 
to the NetWare for SAA server under the username specified in the Access Information 
window.



Current User Button
Retains the previous connection to the NetWare server. It does not attach you to the 
NetWare for SAA server under the username specified in the Access Information window.



Cancel Button
Removes the NetWare for SAA server from the managed domain and returns to the 
NetWare for SAA Services Manager application window.



Pie Settings Window
Allows you to select statistical attributes and pie settings for the selected object.



OK Icon
Closes the Pie Settings window and opens the Pie Statistics window with the specified 
settings.



Statistical Attributes
Lists the attributes available for the selected object or service component.



Style
Sets the counter style to the selected style of 3-D or 2-D.



Interval
Indicates the time in minutes between polling intervals.



Pie Statistics Window
Displays statistics in a pie chart.



Pie Icon
Closes the Pie Statistics window and returns you to the Pie Settings window.



Sample Interval
Indicates the interval value specified in the Pie Settings window.



Time Polling
Indicates the total amount of time polling has been in effect.



Pie Chart Legend
Describes the data and attribute settings used to represent the data. The Legend button 
displays or hides the legend.



Legend Button
Displays or hides the legend for the pie chart.



Number Button
Displays y axis values in numerical format.



Percentage Button
Displays y axis values in percentage format.



Counter Clockwise Rotation Button
Rotates the pie chart counterclockwise.



3-D Orientation Button
Changes the pie chart to three-dimensional view.



2-D Orientation Button
Changes the pie chart to two-dimensional view.



Server Management Options Window
Allows you to change network management options and to access a NetWare for SAA 
server's log files

Related Topics
Accessing Audit Trail Log Files 
Accessing Event Log Files Through the Server Management Options Window
Audit Trail Window 
Changing Server Management Options 
Restarting or Bringing Down the Communication Executive v1.2
Event Log Window 



Event Log Icon
Opens the Event log file.



Clear Log Icon
Removes all entries from the Event Log file.



Audit Trail Log Icon
Opens the Audit Trail log file.



Ok Icon
Closes the Server Management Options window and saves the current settings.



Management Options 
Determines whether the NetWare for SAA server maintains an event log file; maintains 
an audit trail log file; turns the trace facility on and off; turns the NetWare 
communications security feature on and off; and sets NetView alerts, commands, and 
security. NetView options are available only if NetView is enabled for the specified 
NetWare for SAA server.



Event Forwarding Filter
Determines the objects and severity levels for which the server will forward event 
messages to NetWare for SAA Services Manager.    The default is all objects and severity 
levels selected.



Save Selected List to Disk Check Box
Saves the specified event forwarding filter settings to disk so they remain in effect until 
they are changed from the NetWare for SAA Services Manager workstation or the 
NetWare for SAA server.    These settings default back to the CSCON settings the next 
time the Communication Executive is reloaded or restarted.



Server Management Options Window v1.2
Allows you to change server management options and access log files for NetWare for 
SAA v1.2 servers.    This window also allows you to unload and restart the 
Communications Executive v1.2.



Event Log Icon
Opens the Event Log file.



Clear Log Icon
Removes all entries from the Event Log file.



Audit Trail Log Icon
Opens the Audit Trail Log file.



CSDOWN Icon
Brings down the NetWare for SAA v1.2 service.



CSRESTART Icon
Restarts the NetWare for SAA v1.2 service.



Ok Icon
Closes the Server Management Options window and applies the current settings.



Management Options
Determines whether the NetWare for SAA server maintains an event log file; an audit 
trail log file; turns the trace facility on and off; turns the NetWare communications 
security feature on and off; and sets NetView alerts, commands, and security. NetView 
options are available only if NetView is enabled for the specified NetWare for SAA server.



Event Forwarding Filter
Determines the objects and severity levels for which the server will forward event 
messages to NetWare for SAA Services Manager.    The default is all objects and severity 
levels selected.



Save Selected List to Disk Check Box
Saves the specified event forwarding filter settings to disk so they remain in effect until 
they are changed from the NetWare for SAA Services Manager workstation or the 
NetWare for SAA server.    These settings default back to the CSCON settings the next 
time the Communication Executive is reloaded or restarted.



Server Status Window
Displays information about a NetWare for SAA server, service profiles, adapters, NLMs, 
LLC protocols (logical links), and communications protocols. This window also allows you 
to load or unload NLMs and protocols and to load, unload, or restart service profiles, 
display session information, and obtain configuration or statistical data.

Related Topics
Loading and Unloading NLMs or Protocols in v1.3 
Loading and Unloading Protocols in v1.2 
Loading, Unloading, or Restarting Services
Server Status Window v1.2 



Service Profile Load Icon
Loads the specified service profile.



Service Profile Unload Icon
Unloads the specified service profile.



Service Profile Restart Icon
Restarts the specified service profile.



NLM Load Icon
Loads the specified NLM.



NLM Unload Icon
Unloads the specified NLM.



Graph Icon
Opens the Graph Settings window for the selected object or service component.



Pie Icon
Opens the Pie Settings window for the selected object or service component.



More Information Icon
Opens a detailed information or configuration window for the selected object.



Sessions Icon
Opens a Sessions window for the selected profile component.



Services List Box
Lists the name, type, and date loaded for services loaded on the NetWare for SAA server.



Profile Configuration List Box
Lists the components of the selected service profile.



NWSAA Profile Text Box
Specifies the NetWare for SAA service profile you want to load and the parameters you 
must specify when loading that service.



Installed Product List Box
Lists the NetWare for SAA services available on the NetWare for SAA server.    If other 
communications services are installed on the server, the product names may also appear
here.



Link Level Protocols in Use List Box
Lists the LLC protocols and communications protocols that a service is using.



Adapters List Box
Lists the adapters installed in a NetWare for SAA server and the link speeds.



NLM Loader List Box
Specifies the NLM or protocol you want to load or unload and in the Argument text box, 
which specifies the parameters you can include when loading or unloading an NLM or 
protocol.



Additional Server Information
Indicates how long the NetWare for SAA server has been up and provides information 
about a NetWare for SAA server's hardware and software.



Server Status Window v1.2
If NetWare for SAA Services Manager is managing a server on which the Communication 
Executive v1.2 is loaded, the Server Status window v1.2 appears.
This window displays information about a NetWare for SAA server, service profiles, 
adapters, LLC protocols (logical links), and communications protocols. This window also 
allows you to bind or unbind protocols; and to load, unload, or restart service profiles; 
display session information; and obtain configuration or statistical data.



Service Profile Load Icon
Loads the specified service profile.



Service Profile Unload Icon
Unloads the specified service profile.



Service Profile Restart Icon
Restarts the specified service profile.



Bind Icon
Links a protocol to a LAN driver and adapter.



Unbind Icon
Removes a protocol from an adapter's LAN driver.



Graph Icon
Opens the Graph Settings window for the selected object or service component.



Pie Icon
Opens the Pie Settings window for the selected object or service component.



More Information Icon
Opens a detailed information window or a configuration window for the selected object.



Sessions Icon
Opens a Sessions window for the selected service profile configuration.



Services List Box
Lists the name, type, and date and time the service profiles were loaded on a NetWare 
for SAA server.



Profile Configuration List Box
Lists the service profile components of the selected service profile.



NWSAA Profile Text Box
Specifies the name of the service profile you want to control.



Link Level Protocols in Use Box
Lists the LLC protocols and communications protocols a service is using.    The Protocol 
text box allows you to specify the communications protocol you want to load or unload.



Adapters List Box
Lists the adapters installed in a NetWare for SAA server.



Additional Server Information
Indicates how long the NetWare for SAA server has been up and provides information 
about a NetWare for SAA server's hardware and software.



Configuration Windows
NetWare for SAA Services Manager enables you to display configuration data for 
adapters, host links, link level protocols, and service profiles.

Adapter Configuration Window 
Logical Link Configuration Window 
Service Profile Configuration Window 
SNA Host Link Configuration Window 



SNA Host Link Configuration Window
Displays configuration data for the selected host link.

Related Topics
Displaying Session Information for LU6.2 
Displaying Session Information for NetWare for SAA 
LU6.2 Sessions Window 
Server Status Window 
SNA Sessions Window 



Host Link Type
Type of connection (SDLC, QLLC, ITRN (IBM Token Ring)) established between the host 
and the communications server.



Maximum LUs
Maximum logical units (LUs) for which the communications server is configured.



Protocol Stack
Name of the protocol stack NLM.



Adapter Name
Name that the NetWare Communication Services administrator assigns to the SNA 
adapter in CSCON.



Adapter Type
Category specified for the adapter in CSCON.    The adapter is classified as either primary
or alternate.



Host Destination Address
Address of the host destination node.



Link Station Role
NetWare for SAA server's role, which is either primary, secondary, or negotiable.



SDLC Encoding
Indicator to determine what other data is encoded for NRZ or NRZI. (No value is listed for
token ring connections.)



Destination SAP
Service access point (SAP) used at the destination end of the logical link.



Source SAP
Service access point (SAP) used at the logical end of the logical link.



PU ID
Unique, five-character SNA node ID that is defined when NetWare for SAA is configured in
CSCON.    This is the same ID that is assigned to that SNA node on the host.



Block ID
Unique, five-character SNA node ID assigned to the physical unit (PU) in CSCON.    This is 
the same ID that is assigned to that PU on the host.



Logical Link Configuration Window
Displays configuration data for the selected logical link protocol.    The information that 
appears may vary depending on the type of protocol selected.



Media Type
Type of physical connection.



Logical Adapter Name
Name that the NetWare Communication Services administrator assigned to the 802.2 
adapter in CSCON.



Protocol Stack Name
Name of the protocol stack NLM.



Source Address
Media access control (MAC) address of the local adapter.



Local SAP Address
Service access point (SAP) used at the logical end of the logical link.



Destination Address
Media access control (MAC) address of the remote node.



Remote SAP Address
Service access point (SAP) at the remote end of the logical link.



Link Station Role
Communications server's role, which is either primary, secondary, or negotiable.    
Negotiable applies during only link setup.



Service Name
Name the NetWare Communication Services administrator assigned to the 
communication service in CSCON.



Host Link Name
Service profile name the NetWare Communication Services administrator assigned to the
host in CSCON.



Remote Node Type
SNA node type of the computer to which the communications server is sending 
information.    Peripheral Node Type 2.1 in this field indicates the remote node is an SNA 
peripheral node with a peer-to-peer connection.    Subarea Node Type 4 in this field 
indicates the remote node is a controller.    Subarea Node Type 5 in this field indicates the
remote node is a host.



Sequence Number Modules
Maximum number of frames the communications server can send before it waits for the 
remote node to send a RR (Receive Ready).



Service Profile Configuration Window
This window provides additional information about the selected service profile.



Service Name
Name of the service profile.



Version
Version number of the SAA service for which the profile is configured.



Start Time
Date and time the service profile was loaded.



Service Description
Full name of the SAA service for which the profile is configured (NetWare for SAA v1.3 
only).



SNA Sessions Detailed Information Window
Displays additional information about an LU listed in the SNA Sessions window.

Related Topics
Displaying Session Information for NetWare for SAA 
SNA Sessions Window 



LU ID
Identifies the local address of the LU. The NetWare for SAA services administrator assigns
this number in CSCON.



LU Type
Indicates whether the LU is type 0, 1, 2, 3, 6.2, or downstream.    The number 6 
represents LU6.2.    The letter D indicates a downstream physical unit (PU).



LU 2 Model Number
Indicates the type of screen model connected to the host.



User Name
Identifies the name of the user specified when logging in to the NetWare for SAA server.



Net Address
Identifies the network address of the user's workstation.



LU Pool Name
Identifies the name of the pool to which the LU is assigned.    The NetWare for SAA 
services administrator assigns this name in CSCON.



LU Status
Indicates the status of both the workstation software and the LU.    The data will be one of
the following:

UP-BND Workstation software is loaded, and the session is 
bound to an application.

UP-ACT Workstation is loaded, and NetWare for SAA has 
received an activate LU request (ACTLU).

UP-INA Workstation software is loaded, but NetWare for 
SAA has not received an activate LU request 
(ACTLU).

DN-BND Workstation software is not loaded, but the session 
is bound to an application.

DN-ACT Workstation software is not loaded, but NetWare for
SAA has received an activate LU request (ACTLU).

DN-INA Workstation software is not loaded, and NetWare 
for SAA has not received an activate LU request 
(ACTLU).



Host Application ID
Identifies the host application to which the LU is bound.



Workstation Up Time
Indicates how long the workstation has been connected to NetWare for SAA.



LU Category
Indicates whether the LU is a dedicated LU, a public LU, or a downstream PU.



VTAM LU Name
Identifies the name assigned to the LU in the VTAM major node definition.    The NetWare 
for SAA administrator should specify the same name that the host systems programmer 
assigns to the LU.



Dedicated LU Name
Identifies the name the NetWare for SAA server administrator assigned to a dedicated 
LU. 



SNA Sessions Window
Displays information about a NetWare for SAA server's SNA sessions.

Related Topics
Controlling Sessions 
Displaying Session Information for NetWare for SAA 
Running SNA Traces 
SNA Sessions Detailed Information Window 
Trace Window 



First Page Icon
Scrolls to the first page of available LU information.



Previous Page Icon
Scrolls to the previous page of available LU information.



Next Page Icon
Scrolls to the next page of available LU information.



Last Page Icon
Scrolls to the last page of available LU information.



More Information Icon
Opens the SNA sessions Detailed Information window and displays additional information
about the selected LU.



Update Icon
Updates the SNA Sessions window with the most recent session information. 



Lock Icon
Prevents users from using a session. Anyone using the session when you choose the Lock
icon is disconnected from that session. (Lock is available only if the current session is 
unlocked.)



Unlock Icon
Gives users access to a session. (Unlock is available only if the current session is locked.)



Sessions Softreset Icon
Disconnects users from a session without terminating the assignment of the LU. After you
choose this icon, an SNA TERM-SELF request is sent to the host and the user is returned 
to his or her initial login screen. The user can restart the session.



Sessions Hardreset Icon
Disconnects users from a session without terminating the assignment of the LU. The user
can restart the session. The effect clicking this icon has depends on the application the 
user was running on the host.



Trace Icon
Access the Trace window.



Maximum LUs
Indicates the maximum number of dependent LUs your copy of NetWare for SAA can 
support.    For dependent LUs, the maximum number of sessions is the same as the 
maximum number of LUs.



Active LUs
Indicates how many LUs are activated by the host and are assigned to workstations.



Host Connection Type
Identifies the type of link that exists between the NetWare or SAA server and the host as 
either SDLC, ITRN (IBM Token Ring), QLLC, 802.2, CUSTOM, or SELF TEST.



Host Link Status
Indicates whether the NetWare for SAA server and the host are connected or 
disconnected.



Session Number
Indicates which session is selected.



Session Status
Indicates whether the session selected is locked or unlocked.



Session Display
The Display LU option button displays session information for a single LU and the Display 
Pool option button displays session information for all the LUs in an LU pool.



LU
Identifies the local address of the LU.    The NetWare for SAA services administrator 
assigns this number in CSCON.



T (Type)
Indicates whether the LU is type 0, 1, 2, 3, 6.2 or downstream.    The number 6 represents
LU6.2 and the letter D indicates a downstream physical unit (PU).



User Name
Identifies the name the user specified when logging in to the NetWare for SAA server.



Net Address
Identifies the network address of the user's workstation.



LU Pool
Identifies the name of the pool to which the LUs are assigned.    The NetWare for SAA 
services administrator assigns this name in CSCON.    This field is blank if the LU is not 
assigned to a pool.



Status
Indicates the status of both the workstation software and the LU.    The data will be one of
the following:

UP-BIND Workstation software is loaded, and the session is 
bound to an applications.

UP-ACT Workstation is loaded, and NetWare for SAA has 
received an activate LU request (ACTLU).

UP-INA Workstation software is loaded, but NetWare for 
SAA has not received an activate LU request 
(ACTLU).

DN-BND Workstation software is not loaded, but the session 
is bound to an application.

DN-ACT Workstation software is not loaded, but NetWare for
SAA has received an activate LU request (ACTLU).

DN-INA Workstation software is not loaded, and NetWare 
for SAA has not received an activate LU request 
(ACTLU).



Application ID
Identifies the name of the host application to which the LU is bound.



Workstation Up Time
Indicates how long the workstation has been connected to NetWare for SAA.



Trace Window
Starts and stops SNA traces for LU 0, 1, 2, 3, or downstream PU sessions.

Related Topics
Running SNA Traces 
SNA Sessions Window 



Start Trace Icon
Starts the trace process.



Stop Trace Icon
Stops the trace process.



Options
Specifies that all LUs or only one LU is to be traced and the number of the LU that you 
want to trace if you select Single LU.



File Size Text Box
Specifies the trace file's size.



File Name Text Box
Specifies the trace file's name



User Information Window
Displays information about the users accessing NetWare for SAA server or services.

Related Topic
Obtaining User Information



Update Icon
Updates the User Information window with the most recent user information.



Number of Users 
Indicates how many users are using the NetWare for SAA server.



User Name
Identifies the ID assigned to the user on the NetWare for SAA server.    Downstream PU 
and HOSTPRT appear as usernames for the Downstream PU and Host Print connections of
the server.



Full Name
Identifies the name assigned to the user on NetWare for SAA server. 



Up Time
Indicates how long the user has been using the NetWare for SAA service.



Protocol
Indicates which network protocol the user's workstation is using.    



Network Address
Indicates the address of the user's workstation. 



Profile
Indicates the service profile for the selected user or service connection.    This data 
appears when you double-click an entry in the user's list box.



LU
Identifies the local address of the LU associated with the selected user or service.    The 
NetWare for SAA administrator assigns this number in CSCON.    This data appears when 
you double-click an entry in the user's list box.



Product ID
Identifies the communications service product used by the selected user or service.    
This data appears when you double-click an entry in the user's list box.



Start Time
Identifies when the LU connection was established for the selected user or service.    This 
data appears when you double-click an entry in the users list box.





Accessing Audit Trail Log Files
Access an audit trail log file to display information that identifies who uses which network
resources, when, and for how long.
To access audit trail log files, take the following steps:

1. In the Active Domain window, select the server maintaining the audit trail log file 
you want to examine.

2. Click the Server Management Options icon in the Tool Bar.
NetWare for SAA Services Manager opens the Server Management Options 
window. 

3. Click the Audit Trail Log icon in the Tool Bar.
NetWare for SAA Services Manager opens an Audit Trail window. This window lists 
the records made in the NetWare for SAA server's audit trail log file.

4. To display additional audit trail information, either select the record you want 
information about and click the More Information icon in the Tool Bar or double-
click the record.
NetWare for SAA Services Manager opens an Audit Trail Detailed Information 
window, which lists additional information about the selected record.

Related Topics
Active Domain window 
Audit Trail Detailed Information Window 
Audit Trail Window 
Server Management Options Window 



Accessing Event Log Files Through the Event Monitor Window
Accessing an event log file allows you to obtain a chronological listing of all network 
events that occurred on the server and examine event messages recorded in the event
log file but not listed in the Event Monitor window.

To access an event log file through the Event Monitor window, take the following steps: 
1. In the Event Monitor window, select an event message recorded in the event log 

file you want to view.
Be sure to select a message describing an event detected by a NetWare for SAA 
server included in the active domain.

2. Click the Event Log icon in the Tool Bar.
NetWare for SAA Services Manager opens an Event Log window, which displays the
event log file records of the NetWare for SAA server associated with the selected 
event message.

3. To display additional record information, either select an event record and click the
More Information icon in the Tool Bar or double-click the event record.
NetWare for SAA Services Manager opens an Event Record Detailed Information 
window.

You can also access a server's event log file through the Server Management Options 
window.
Related Topics
Accessing Event Log Files Through the Server Management Options Window 
Accessing Additional Event Record Information 
Event Log Window 
Event Monitor Window 
Event Record Detailed Information Window 



Accessing Event Log Files Through the Server Management 
Options Window

Accessing an event log file allows you to obtain a chronological listing of all network 
events that occurred on the server and examine event messages recorded in the event
log file but not listed in the Event Monitor window.

To access an event log file through the Server Management Options window, take the 
following steps:

1. In the Active Domain window, select the server maintaining the event log file you 
want to view.

2. Click the Server Management Options icon in the Tool Bar.
NetWare for SAA Services Manager opens the Server Management Options 
window.

3. Click the Event Log icon in the Tool Bar.
NetWare for SAA Services Manager opens an Event Log window, which displays the
records of the NetWare for SAA server's event log file.

4. To access additional event record information, either select an event record and 
click the More Information icon in the Tool Bar or double-click the event record.
NetWare for SAA Services Manager opens an Event Record Detailed Information 
window.

Related Topics
Accessing Event Log Files Through the Event Monitor Window 
Accessing Additional Event Record Information 
Event Log Window 
Event Record Detailed Information Window 
Server Management Options Window 



Accessing Additional Event Record Information
You can access additional event record information while examining event messages 
listed in the Event Monitor or Event Log window. If you access event records through the 
Event Log window, NetWare for SAA Services Manager obtains event record information 
from the NetWare for SAA server's database. 
To access event records while examining an event log file, take the following steps: 

1. In the Event Monitor or Event Log window, select the event message that 
describes the event you want more information about.

2. Either click the More Information icon in the Tool Bar or double-click the event 
message.
NetWare for SAA Services Manager opens an Event Record Detailed Information 
window. 

Related Topics
Accessing Event Log Files Through the Event Monitor Window 
Accessing Event Log Files Through the Server Management Options Window 
Event Monitor Window 
Event Record Detailed Information Window 
Server Management Options Window 



Adding Servers to the Managed Domain
If you want NetWare for SAA Services Manager to manage or monitor a NetWare for SAA 
server, add the server to the managed domain by taking the following steps:

1. Click the Change Managed Domain icon in the Tool Bar.
NetWare for SAA Services Manager opens the Change Managed Domain window.

2. Specify which NetWare for SAA servers you want to add. How you add a server 
depends on whether the server is listed in the Available Comm. Servers list box. 
(You must have supervisor-equivalent or file server console operator privileges on 
any available servers you want to add.)

To add a server listed in the Available Comm. Servers list box, select the server's 
name from the Available Comm. Server's list box and then click the Add icon. You may also 
double-click the server's name in the Available Comm. Servers list box.

To add a server that is not listed in the Available Comm. Servers list box, type the 
server's name in the Server Name text box and then press <Enter>. If the server is currently
unavailable, it will be added to the active domain when it becomes available.

When adding servers, you can select several server names at a time by holding 
down <Ctrl> while clicking the server names you want to add.

3. Repeat Step 2 until the Managed Domain list box contains the names of all the 
servers you want included in the managed domain.

4. Select the Save Managed Domain list box if you want to save the specified 
managed domain. Otherwise, clear the check box.

5. Click the OK icon.
NetWare for SAA Services Manager closes the Change Managed Domain window 
and then displays the Access Information window. In that window, specify user 
name and password information for those servers. After you specify a valid user 
name and password for a NetWare for SAA server, the Active Domain window 
displays server icons or only server names for the servers included in the active 
domain.

Related Topics
Access Information Window 
Active and Managed Domains 
Change Managed Domain Window 
Redefining the Managed Domain 
Removing Servers from the Managed Domain 



Changing Server Management Options
You can specify server management options that affect the processing of NetView 
commands or alerts, server log files, server security, trace facility, and the event 
forwarding filter.

Note: These options can also be set in CSCON (NetWare for SAA v1.2 or v1.3), 
CSSET (NetWare for SAA v1.2), or CSSTATUS (NetWare for SAA v1.3). The settings 
specified in NetWare for SAA Services Manager take effect immediately. However, 
they default back to the settings specified in CSCON if the Communication 
Executive is reloaded or restarted after the options are reset.

To change server management options with NetWare for SAA Services Manager, take the 
following steps. (Supervisor-equivalent privileges are required.)

1. In the Active Domain window, select the server you want to configure.
2. Click the Server Management Options icon in the Tool Bar.

NetWare for SAA Services Manager opens the Server Management Options 
window. 

3. If the server is to maintain an event log file, specify Event Log options by taking 
the following steps:
a. Select the Event Log State check box to enable logging. The default is Event 

Log State on.
b. If you want to delete the current contents of the event log file, click the Clear 

Event Log icon. Otherwise, new information will be appended to the log file. 
You will be unable to clear an event log file if another person is viewing the file 
at the same time that you are.

4. If the server is to maintain an audit trail log file, select the Audit Trail State check 
box. The default is Audit Trail State on.

5. If you want to be able to run SNA traces, select the Trace check box. Otherwise, 
clear that check box. The default is Trace on.

6. To turn on the NetWare communications security feature , select the Security 
check box. Otherwise, clear that check box. The default is security on.

7. If NetView is enabled in CSCON, you may select one or more of the following 
NetView options:

NetView Alerts
Select this option if NetView alerts occurring on a NetWare for SAA server are to
be forwarded to the IBM NetView facility. The default is NetView Alerts on.

NetView Commands
Select this option if the NetWare for SAA server is to process commands issued 
by the NetView operator. The default is NetView Commands on.

NetView Security
Select this option if the NetWare for SAA server is to verify that NetView 
operators have permission to issue commands to the server from the host. The 
default is NetView Security on.

8. To select the objects and severity levels for which the NetWare for SAA server is to 
forward events to NetWare for SAA Services Manager, select and deselect the 
event forwarding filter objects and severity levels. The default is all objects and 
severity levels selected.    
To save the selected event forwarding filter settings, select the Save selected list 
to disk check box. The default is save settings.



9. To save the specified management options settings, click the OK icon.    NetWare 
for SAA Services Manager saves the management options settings and closes the 
Server Management Options window.

Related Topics
Accessing Audit Trail Log Files 
Accessing Event Log Files Through the Event Monitor Window 
Accessing Event Log Files Through the Server Mangement Options Window 
Event Monitor Window 
Display and Event Forwarding Filters 
Running SNA Traces 
Server Management Options Window 
Server Management Options Window v1.2 



Clearing Event Messages
Clearing an event message deletes it from the Event list box of the Event Monitor 
window.
To clear an event message, select the message in the Event Monitor window's Event list 
box and then click the Remove Event icon.
Related Topic
Event Monitor Window 



Collecting and Displaying Statistical Data
Collect and display statistical data to obtain information that can help you measure 
network performance, identify network faults, and address potential performance 
problems before critical bottlenecks occur.
To collect and display statistical data about a host link, adapter, or link level control (LLC)
protocol (logical link), take the following steps:

1. In the Active Domain window, select the server you want information about.
2. Click the Server Status icon in the Tool Bar.

NetWare for SAA Services Manager opens the Server Status window.    You may also
double-click the server icon in the Active Domain window to access the Server 
Status window.

3. Select the host link, logical link, or adapter you want information about and click 
the Graph icon or Pie icon in the Tool Bar.
NetWare for SAA Services Manager opens a Pie Settings window or a Graph 
Settings window. 

5. In the Settings window, select the attributes you want information about.
6. In the Interval text box, type the number of minutes you want to elapse between 

NetWare for SAA Services Manager statistical data requests.
7. In the Total Samples text box, type the maximum number of times you want 

NetWare for SAA Services Manager to collect data.
8. If you want to reset the value of the attributes listed in the Graphable Attributes 

list box, select the Reset Attributes check box. Otherwise, clear the check box.
9. Click the OK icon to start the data collection process.

NetWare for SAA Services Manager begins collecting the statistical data and then 
displays it in the Statistics window for the type of graphic you selected.

10. After NetWare for SAA Services Manager has collected all the information you 
want, stop the data collection process. To do this, either close the Statistics 
window or click the Graph or Pie icon in the Tool Bar to return to the Settings 
window.

Note: If you close the Graph or Pie Statistics window, you will lose the data 
NetWare for SAA Services Manager has collected.

Related Topics
Statistical Attributes 
Graph Settings Window 
Graph Statistics Window 
Pie Settings Window 
Pie Statistics Window 



Controlling Sessions
Control SNA sessions if you want to prevent workstation users from using a session, give 
workstation users access to a session, or force workstation users to quit an application 
they are using on the host.
To control sessions, take the following steps. (Supervisor-equivalent privileges are 
required.)

1. In the Active Domain window, select the server establishing the session you want 
to control.

2. Click the Server Status icon in the Tool Bar.
NetWare for SAA Services Manager opens a Server Status window.    You can also 
double-click a server icon in the Active Domain window to access the Server Status
window.

3. In the Services list box, select the service profile providing the session you want to 
display information about and select PU 2.0 Sessions from the Profile Configuration
list box.

4. Either click the Session icon in the Tool Bar or double-click PU 2.0 Sessions.
NetWare for SAA Services Manager opens an SNA Sessions window.

5. Select the session you want to control.
6. Control the session by performing one of the following operations:
Click the Lock icon to prevent users from using the session. Anyone using the session

when you click this icon is disconnected from that session. (The Lock icon is available only if 
the current session is unlocked.)

Click the Unlock icon to give workstation users access to the session. (Unlock is 
available only if the current session is locked.)

Click the Sessions Softreset icon to disconnect the user from the session without 
terminating the assignment of the LU. The user can restart the session. After you click the 
Sessions Softreset icon, an SNA TERM-SELF request is sent to the host and the user is 
returned to his or her initial login screen.

Click the Sessions Hardreset icon to disconnect the user from the session without 
terminating the assignment of the LU. After the user's workstation displays a communication
error, the user can restart the session. The effect of clicking the Sessions Hardreset icon 
depends on the application the user was running on the host.

Note: Before controlling a session with the Sessions Hardreset icon, warn the 
session's users that you will be disconnecting them from the NetWare for SAA 
server.

Related Topics
Displaying Host Link Dependent Data 
Server Status Window 
SNA Sessions Window 



Copying
NetWare for SAA Services Manager allows you to copy the current data of a specific list 
box, option button, text box, or active NetWare for SAA Services Manager window. Copy 
such data if you want to copy data to another Microsoft Windows application that 
supports the DDE format, such as Microsoft Excel, or transfer the data to another 
Windows application that supports the Text format, such as Microsoft Word for Windows.
To copy data, take the following steps:

1. Ensure that the window you want to copy information from is the active window.
2. Specify which data is to be copied by completing one of the following operations:
To copy an option button or check box, select the option button or check box you 

want to copy. You cannot copy cleared option buttons or check boxes.
To copy data included in a text box, position the pointer in the text box containing the

data you want to copy.
To copy data listed in a list box, select one of the items listed in the list box. If the list 

box is empty and you plan to establish a DDE link to that list box, copy the empty list box. 
(After the list box receives data, NetWare for SAA Services Manager will update the other 
Microsoft Windows application to which the DDE link is established.)

3. Choose the Edit menu and select Copy (<Alt+E+C>).
NetWare for SAA Services Manager copies the data specified in Step 2 to the 
Windows clipboard.

4. Switch to the Program Manager as discussed in your Microsoft Windows 
documentation.

5. Open the application to which you want to transfer the information, and use that 
program's commands to copy the information from the Windows clipboard to the 
appropriate place.

Note: If you use Microsoft Excel to establish DDE links, both NetWare for SAA 
Services Manager and Excel must be open to maintain the links.

Related Topics
Edit Menu 
Output Window 
Saving Data to the Windows Clipboard 



Customizing the Displaying and Notification of Events
Customize the displaying and notification of events to specify how many event messages
NetWare for SAA Services Manager can monitor at the same time, set the display filter, 
control whether NetWare for SAA Services Manager displays event messages in color, 
specify which event severity levels the server icons indicate in color, and determine 
which events NetWare for SAA Services Manager notifies you about by beeping.
To customize the displaying and notification of network events, take the following steps:

1. Click the Customize icon in the Tool Bar of the Event Monitor window.
NetWare for SAA Services Manager opens a Customize Events window.

2. In the Maximum Number of Local Events text box, type the maximum number of 
events that NetWare for SAA Services Manager can monitor at the same time.
You can specify any number from 1 to 500.    The default is 64 messages.

3. Set the display filter by selecting the Display check boxes that correspond to the 
severity levels of the events NetWare for SAA Services Manager is to display 
messages for. 

4. If NetWare for SAA Services Manager is to indicate an event's severity by 
displaying event messages in color, select the Display with Colors check box. 
Otherwise, clear that check box.

5. Select the Server Icon Color check boxes that correspond to the severity levels you
want NetWare for SAA Services Manager to indicate with color when displaying 
server icons.
If NetWare for SAA Services Manager receives an event message, it can indicate 
the event's severity by displaying the server icon in the Active Domain window in 
color. The colors will be the same as those used for the event messages. The 
server icon's color changes only if both of the following are true:

The event's severity level is selected in the Server Icon Color check boxes.
The event's severity level is higher than the severity level of events NetWare for SAA 

Services Manager previously received.
If the Event Monitor window is closed and then reopened, NetWare for SAA 
Services Manager will display server icons in green regardless of the NetWare for 
SAA server's status.

6. If you want NetWare for SAA Services Manager to beep whenever it receives event
messages of a particular severity level, select the Audible Alert check box that 
matches the desired severity levels.
If you specify an audible alert for a severity level, you also must specify that 
NetWare for SAA Services Manager display events with that severity level.

7. Click the OK icon.
NetWare for SAA Services Manager saves the specified settings so that they are 
used the next time NetWare for SAA Services Manager is started.

Related Topics
Customize Events Window 
Displaying Event Messages in Color 
Displaying Server Icons in Color 
Event Monitor Window 
Setting the Audible Alert 
Setting the Display Filter 
Specifying Number of Event Messages 





Displaying Event Messages in Color
NetWare for SAA Services Manager can display event messages in color, which helps you
quickly identify the severity of a network event.
To display event messages in color, take the following steps:

1. Click the Customize icon in the Tool Bar from the Event Monitor window.
NetWare for SAA Services Manager opens the Customize Events window.

2. If NetWare for SAA Services Manager is to indicate an event's severity by 
displaying event messages in color, select the Display with Colors check box. 
Otherwise, clear that check box.

3. Click the OK icon.
NetWare for SAA Services Manager saves the specified settings so that they are 
used the next time NetWare for SAA Services Manager is started.

Related Topics
Customize Events Window 
Event Monitor Window 
Severity Level Colors 



Displaying the Percentage of Memory Used
To display the percentage of memory NetWare for SAA Services Manager is using, choose
the Help Menu and select About NetWare for SAA Services Manager (<Alt+H+A>). The 
percentage of memory used along with version information is displayed.
Related Topic
Help Menu 



Displaying Server Icons in Color
NetWare for SAA Services Manager can display server icons in color, which helps you 
quickly identify a NetWare for SAA server's status.
To display server icons in color, take the following steps:

1. Click the Customize icon in the Tool Bar from the Event Monitor window.
NetWare for SAA Services Manager opens the Customize Events window.

2. Select the Server Icon Color check boxes that correspond to the severity levels you
want NetWare for SAA Services Manager to indicate with color when displaying 
server icons.
The colors will be the same as those used for event messages. The server icon's 
color changes only if both of the following are true:

The event's severity level is selected in the Server Icon Color check boxes.
The event's severity level is higher than the severity level of events NetWare for SAA 

Services Manager previously received.
If the Event Monitor window is closed and then reopened, NetWare for SAA 
Services Manager will display server icons in green regardless of the NetWare for 
SAA server's status.

3. Click the OK icon.
NetWare for SAA Services Manager will save the specified settings so that they are
used the next time NetWare for SAA Services Manager is started.

Related Topics
Customize Events Window 
Event Monitor Window 
Severity Level Colors 



Displaying Session Information for LU6.2
To display LU6.2 session information, take the following steps:

1. In the Active Domain window, select the server establishing the session you want 
to control.

2. Click the Server Status icon in the Tool Bar.
NetWare for SAA Services Manager opens a Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. In the Services list box, select the service profile providing the session you want to 
display information about and select PU 2.1 Sessions from the Profile Configuration
list box. Either click the Sessions icon in the Tool Bar or double-click PU 2.1 
Sessions.
NetWare for SAA Services Manager opens an LU6.2 Sessions window. That window 
displays information about the NetWare for SAA server's LU6.2 sessions.
SAA Services Manager does not automatically update the contents of the LU6.2 
Sessions window as the LU6.2 session information changes. To keep the session 
information current, click the Update icon in the Tool Bar.

Related Topics
LU 6.2 Detailed Information Window 
LU 6.2 Sessions Window 
Server Status Window 



Displaying Host Link Dependent Data
You can display information for NetWare for SAA that provides you with data about SNA 
LU 0, 1, 2,and 3 sessions, and downstream PU sessions. To do so, take the following 
steps:

1. In the Active Domain window, select the server establishing the session you want 
to control.

2. Click the Server Status icon from the Tool Bar.
NetWare for SAA Services Manager opens the Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. In the Services list box, select the service profile providing the session you want to 
display information about and select PU 2.0 Sessions from the Profile Configuration
list box. Either click the Sessions icon in the Tool Bar or double-click PU 2.0 
Sessions.
NetWare for SAA Services Manager opens an SNA Sessions window. This window 
displays information about a NetWare for SAA server's SNA LU 0, 1, 2, and 3 
sessions and downstream PU sessions.
NetWare for SAA Services Manager does not automatically update the contents of 
the SNA Sessions window as the session information changes. To keep the session 
information current, click the Update icon in the Tool Bar.

Related Topics
Controlling Sessions 
Server Status Window 
SNA Sessions Detailed Information Window 
SNA    Sessions Window 



Exiting NetWare for SAA Services Manager
Exit NetWare for SAA Services Manager whenever you no longer want to monitor or 
manage the NetWare for SAA servers specified in the managed domain.
To exit NetWare for SAA Services Manager, choose the File menu and then select Exit 
(<Alt+F+X>) or close the application window.
When making configuration changes, such as redefining the managed domain or altering
event filter settings, you are given the option of saving those changes. If you specified 
you wanted to save those changes, NetWare for SAA Services Manager saves the 
changes when you exit NetWare for SAA Services Manager.
Related Topics
File Menu 
NetWare for SAA Services Manager Application Window 



Loading, Unloading, or Restarting Services
NetWare for SAA Services Manager allows you to load, unload, or restart service profiles. 
To do so, take the following steps. (Supervisor-equivalent privileges are required.) 

1. In the Active Domain window, select the server running the service profile you 
want to control.

2. Click the Server Status icon in the Tool Bar.
NetWare for SAA Services Manager opens the Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. Either select the name of the profile you want to control or type the name in the 
NWSAA Profile text box.

4. Load, unload, or restart the service profile by clicking the Load Service, Unload 
Service, or Restart Service icon in the Tool Bar.

Note: Before you continue to use NetWare for SAA Services Manager after 
restarting a service, verify that the service has restarted. If the service has 
restarted, NetWare for SAA Services Manager lists the service in the Server Status
window. However, if the restart fails, NetWare for SAA Services Manager displays 
a status message that describes why the restart failed.

Related Topic
Server Status Window 



Loading and Unloading NLM Files or Protocols in v1.3
NetWare for SAA Services Manager allows you to load and unload NLM files or LLC 
protocols (logical links) on a    NetWare for SAA v1.3 server.
To load or unload NLM files or protocols, take the following steps. (Supervisor-equivalent 
privileges are required.) 

1. In the Active Domain window, select the server on which you want to load or 
unload an NLM or protocol.

2. Click the Server Status icon in the Tool Bar.
NetWare for SAA Services Manager opens the Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. In the NLM Loader text box, type the filename of the NLM or protocol you want to 
load or unload. 
If you are unsure of an NLM filename, see the documentation for that NLM.
Typically you specify a protocol by typing the filename listed in the Link Level 
Protocols in Use list box. 

4. In the NLM Loader text box, also type any arguments or parameters that you must 
specify when loading or unloading the NLM.
For details on which parameters you need to specify, see the documentation for 
the NLM you want to load or unload.
If you specify an incomplete set of parameters when loading an NLM, a prompt for 
the missing parameters appears on the server console. The NLM does not begin 
operating until the missing information is entered at the server console. You are 
not notified on the NetWare for SAA Services Manager workstation about the 
missing parameters and you may not be aware that the NLM is not operating.

5. Perform one of the following operations:
Load the NLM by clicking the NLM Load icon.
Unload the NLM by clicking the NLM Unload icon.

An NLM will not be unloaded if that NLM is exporting functions and symbols to 
another NLM. If an NLM fails to unload, a message appears on the system 
console. You are not notified on the NetWare for SAA Services Manager 
workstation about the failure and may not be aware that the NLM is not 
operating.

Related Topics
Loading and Unloading Protocols in v1.2 
Server Status Window 



Loading and Unloading Protocols in v1.2
NetWare for SAA Services Manager allows you to load and unload link level protocols 
loaded on a NetWare for SAA server on which the Communication Executive v1.2 and 
NetWare for SAA v1.2 are loaded.    These link level protocols provide the Communication 
Executive support for IPX, SPX, TCP/IP, AppleTalk drivers.
To load or unload protocols, take the following steps. (Supervisor-equivalent privileges 
are required.)

1. Verify that the adapter and its driver are installed on the NetWare for SAA server.
2. In the Active Domain window, select the server you want information about.
3. Click the Server Status icon in the Tool Bar.

SAA Services Manage opens the Server Status window.    You can also access the 
Server Status window by double-clicking a server icon in the Active Domain 
window.

4. In the Protocol text box, type the name of the protocol you want to load or unload.
The Protocols list box will not include SPX, TCP/IP, or AppleTalk even if those 
protocols are being used.

5. In the Tool Bar,:
Click the Bind icon to load the logical link protocol and link a LAN driver and adapter 

to the protocol.
Click the Unbind icon to unload the logical link protocol remove it from an    adapter's 

LAN driver.
Related Topics
Loading and Unloading NLMs or Protocols in v1.3 
Server Status Window 



Obtaining Configuration Data
To obtain and display configuration information for a service profile, host link, adapter, or
logical link,    take the following steps:

1. In the Active Domain window, select the server you want information about.
2. Click the Server Status icon from the Tool Bar.

NetWare for SAA Services Manager opens the Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. Specify whether you want to obtain information about a service, profile, host link, 
adapter, or LLC protocol (logical link).

4. Either select the object you want configuration data for and click the More 
Information icon in the Tool Bar or double-click the object.
NetWare for SAA Services Manager opens a Configuration window, which contains 
the configuration data of the service profile, host link, adapter, or protocol you 
selected in Step 3 .

Related Topics
Configuration Data 
Server Status Window 



Obtaining User Information
Obtain user information to find out who is using a NetWare for SAA server or service, 
what their NetWare addresses are, and which LAN protocol and services they are using. 
To obtain user information, take the following steps. 

1. In the Active Domain window, select the server you want information about.
2. Click the Users icon in the Tool Bar.

NetWare for SAA Services Manager opens the User Information window. 
3. Double-click an entry in the services list box to display additional user information.

NetWare for SAA Services Manager does not automatically update the contents of 
the list boxes as user information changes. To keep the user information current, 
click the Update icon in the Tool Bar.

Related Topic
User Information Window 



Overriding Existing Connections
When NetWare for SAA Services Manager displays the Override Existing Connection 
window, you may establish a connection to the NetWare for SAA server under a 
username different from the one that is currently establishing a connection. Do so if you 
want to sever an existing connection and then establish a new connection under a name 
that provides you operator or supervisor-equivalent privileges.
To override an existing connection, click the New User button from the Override Existing 
Connection window. To retain the previous connection, click the Current User button. 
Clicking Cancel removes the server from the managed domain and returns to the 
NetWare for SAA Services Manager application window.
Related Topics
Access Information Window 
Override Existing Connection Window 
Retaining Previous Connections 



Printing
NetWare for SAA Services Manager allows you to print data recorded in a NetWare for 
SAA server's log files or data displayed in the active NetWare for SAA Services Manager 
window.
To print, take the following steps:

1. Ensure that the window you want to print from is the active window.
2. Choose the File menu and select the Output command (<Alt+F+O>).

NetWare for SAA Services Manager opens the Output window.
3. Specify the type of information you want to print by selecting Screen or Server's 

Database option button. (The Server's Database option button is available only 
when the Audit Trail window or Event Log window is active.)
The effect of selecting Server's Database depends on whether the Audit Trail or 
Event Logs window is active. If you select Server's Database when the Audit Trail 
window is active, NetWare for SAA Services Manager prints the server's audit trail 
log file. If you select Server's Database when the Event Logs window is active, 
NetWare for SAA Services Manager prints all the event log records stored in the 
server's database.

4. Select Printer from the Output To list.
5. Click the Output button.

NetWare for SAA Services Manager sends the specified information to the selected 
printed.

Related Topics
File Menu 
Output Window 



Redefining the Managed Domain
Redefine the managed domain as the network or your needs change. To redefine the 
managed domain, take the following steps:

1. Click the Change Managed Domain icon in the Tool Bar.
NetWare for SAA Services Manager opens the Change Managed Domain window.

2. Specify which NetWare for SAA servers you want to add or remove by adding 
servers to or removing servers from the Managed Domain list box.
How you add a server depends on whether the server is listed in the Available 
Comm. Servers list box. (You must have supervisor-equivalent or file server 
console operator privileges on any available servers you want to add.)

To add a server listed in the Available Comm. Servers list box, select the server's 
name from the Available Comm. Server's list box and then click the Add icon. You can also 
double-click the server name in the Available Comm. Servers list box.

To add a server that is not listed in the Available Comm. Servers list box, type the 
server's name in the Server Name text box and then press <Enter>.    If a server is currently 
unavailable, it is added to the managed domain when it becomes available.

To remove a server, select that server's name from the Managed Domain list box 
and then click the Delete icon. You can also double-click the server name in the 
Managed Domain list box.
Removing a server from the managed domain also deletes the user name and 
password that you may have saved when specifying information in the server's 
Access Information window.
When adding or removing servers, you can select more than one server at a time 
by    holding down <Ctrl> while clicking the server names.

3. Repeat Step 2 until the Managed Domain list box contains the names of all the 
servers you want included in the managed domain.
If NetWare for SAA Services Manager is to manage more than 20 servers, you must
increase the number of SPX connections specified in either the NET.CFG file. When 
setting the SPX parameter, take into consideration how many SPX connections are 
being used by other LAN applications.

4. Select the Save Domain list to Disk check box if you want to save the specified 
managed domain. Otherwise, clear the check box.

5. Click the OK icon.
NetWare for SAA Services Manager closes the Change Managed Domain window. 
The Active Domain window no longer contains those servers you removed from the
managed domain. NetWare for SAA Services Manager displays an Access 
Information window for each server you added to the managed domain. You 
specify access information as you did the first time you started NetWare for SAA 
Services Manager. After you provide valid access information for a server, NetWare
for SAA Services Manager displays a server icon or only a server name for that 
server in the Active Domain window.

Related Topics
Access Information Window 
Active and Managed Domains 
Adding Servers to the Managed Domain 
Change Managed Domain Window 
Removing Servers from the Managed Domain 



Removing Servers from the Managed Domain
If you no longer need to monitor or manage a NetWare for SAA server, remove it from 
the managed domain by taking the following steps:

1. Click the Change Managed Domain icon in the Tool Bar.
NetWare for SAA Services Manager opens the Change Managed Domain window.

2. Remove a server by selecting its name from the Managed Domain list box and 
then clicking the Delete icon or double-clicking the server's name. 

3. Repeat Step 2 until you have removed all the servers that you no longer want 
NetWare for SAA Services Manager to manage or monitor.

4. Select the Save Domain list to Disk check box if you want to save the specified 
managed domain. Otherwise, clear the check box.

5. Click the OK icon.
NetWare for SAA Services Manager closes the Change Managed Domain window 
and removes the deleted servers from the Active Domain window.

Related Topics
Active and Managed Domains 
Adding Servers to the Managed Domain 
Change Managed Domain Window 
Redefining the Managed Domain 



Restarting or Bringing Down the Communication Executive v1.2
NetWare for SAA Services Manager can restart or bring down the Communication 
Executive loaded on a NetWare for SAA server running NetWare for SAA v1.2.    You can 
also control the NetWare for SAA v1.3 server by loading and unloading the related NLM 
files.    However, you must ensure all the correct NLM files are loaded and unloaded 
properly.

Note: Restarting or bringing down a server's Communication Executive restarts 
or brings down that server's NetWare Communication Services products. Any 
sessions established through those products will be lost.

The following procedure describes how to issue CSRESTART and CSDOWN from the 
NetWare for SAA Services Manager workstation. (Supervisor-equivalent privileges are 
required.)

1. In the Active Domain window, select the server that the Communication Executive 
you want to bring down is loaded on.

2. Click the Server Management icon in the Tool Bar.
NetWare for SAA Services Manager opens a Server Management Options window.

3. Click either the CSRESTART icon or the CSDOWN icon.
Click the CSRESTART icon if you need to restart the Communication Executive without

bringing down the NetWare server.
If you click the CSRESTART icon, NetWare for SAA Services Manager prompts 
you to verify whether you want to restart the Communication Executive. When 
you restart the Communication Executive, all its modules and all the service 
profiles are unloaded and then reloaded. You will not be able to control the 
Communication Executive if the restart fails.

Click the CSDOWN icon if you want to unload all the Communication Executive's 
modules and all the service profiles. If you click the CSDOWN icon, NetWare for SAA Services
Manager prompts you to verify whether you want to bring down the Communication 
Executive.

Note: A Communication Executive brought down with the CSDOWN icon can be 
restarted only from the NetWare server console.

After you restart or bring down the Communication Executive, the network management 
options NetWare for SAA Services Manager can control revert to the settings specified in 
CSCON. 
Related Topic
Server Management Options Window v1.2 



Retaining Existing Connections
When NetWare for SAA Services Manager displays the Override Existing Connection 
window, you may retain a previous connection to a NetWare server.
Do this if you want to retain the previous connection to a NetWare server. You will not, 
however, be attached to the NetWare for SAA server under the username specified in the
Access Information window.
To retain an existing connection, click the Current User button on the Override Existing 
Connection window.
Related Topics
Access Information Window 
Override Existing Connection Window 
Overriding Existing Connections 



Running SNA Traces
While NetWare for SAA Services Manager is displaying SNA LU 0, 1, 2, or 3 information or
downstream PU information, you may run a trace on a single LU or all LUs. Run a trace if 
you suspect a problem with the connection between NetWare for SAA and the host or 
between a workstation and a NetWare for SAA server. Only one trace at a time can be 
run. You cannot run a trace on LU6.2 sessions.
To run an SNA trace, take the following steps. (Supervisor-equivalent privileges are 
required.) 

1. In the Active Domain window, select the server establishing the session you want 
to control.

2. Click the Server Status icon in the Tool Bar. 
NetWare for SAA Services Manager opens the Server Status window.    You can also 
access the Server Status window by double-clicking a server icon in the Active 
Domain window.

3. In the Services list box, select the service profile providing the session you want to 
display information about and select PU 2.0 Sessions from the Profile Configuration
list box. Either click the Sessions icon in the Tool Bar or double-click PU 2.0 
Sessions.
NetWare for SAA Services Manager opens an SNA Sessions window. This window 
displays information about a NetWare for SAA server's SNA sessions.

6. Click the Trace icon in the Tool Bar.
NetWare for SAA Services Manager opens a Trace window.

7. Specify whether you want to trace a single LU by selecting the Single LU option 
button or all LUs by selecting the All LUs option button.

8. If you selected Trace single LU, type the number of the LU you want to trace in the 
LU ID text box. Otherwise, skip this step.

9. In the File size text box, type the number of kilobytes you want allocated for the 
trace file.

10. In the Filename text box, type the name of the trace file.
The filename can be up to 32 characters long. The trace file is saved in the 
NetWare for SAA server's root directory. NetWare for SAA Services Manager warns 
you if you specify an existing filename. If you receive a warning, you need to 
specify another filename because NetWare for SAA does not overwrite existing 
trace files.

11. Click the Trace Start icon in the Tool Bar.
12. When you want to stop the trace, click the Trace Stop icon.

After running the trace, you can convert the trace binary file to ASCII by using the 
TRFORMAT utility as discussed in your NetWare for SAA v1.3 Administration Guide.
Related Topics
Changing Server Management Options 
SNA Sessions Window 
Trace Window 



Saving Data to a File
NetWare for SAA Services Manager allows you to save data stored in a NetWare for SAA 
server's log files or data currently displayed in the active NetWare for SAA Services 
Manager window to a file.
To save information to a file, take the following steps:

1. Ensure that the window containing the information you want to save is the active 
window.

2. Choose the File menu and then select the Output command (<Alt+F+O>).
NetWare for SAA Services Manager opens the Output window.

3. Specify the type of information you want to save by selecting Screen or Server's 
Database.

Select Screen to save the window's current data.
The effect of selecting Server's Database depends on whether the Audit Trail or Event

Log window is active. If you select Server's Database when the Audit Trail window is active, 
NetWare for SAA Services Manager will save the contents of the server's audit trail log file. If 
you select Server's Database when the Event Log window is active, NetWare for SAA 
Services Manager saves all the event log records stored in the server's database.

4. Select Local File from the Output To list.
5. In the Filename text box, type the name of the file the information will be saved in.
6. Click the Output button.

NetWare for SAA Services Manager saves the information in text format to the file 
specified in Step 5.

Related Topics
File Menu 
Output Window 
Saving Data to the Windows Clipboard 



Saving Data to the Windows Clipboard
Data displayed in a window can be saved to the Microsoft Windows clipboard and then 
transferred to another Windows application that supports the text format. (You cannot 
save to the clipboard data listed in the list boxes of the Audit Trail or Event Log windows.)

Note: NetWare for SAA Services Manager also allows you to copy data to the 
Windows clipboard rather than save it to the clipboard. Copying data allows you 
to transfer data to another Windows application that supports the text or DDE 
format.

To save data to the Windows clipboard and then transfer that data to another Windows 
application, take the following steps:

1. Ensure that the window containing the information you want to save is the active 
window.

2. Choose the File menu and select the Output command (<Alt+F+O>).
NetWare for SAA Services Manager opens the Output window.

3. Select Screen from the Output From list. 
4. Select Clipboard from the Output To list.
5. Click the Output button.

NetWare for SAA Services Manager copies the current data of the active window to
the Windows clipboard.

6. Switch to the Program Manager as discussed in your Microsoft Windows 
documentation.

7. Open the application that you want to transfer the information to, and use that 
program's commands to copy the information from the Windows clipboard to the 
appropriate place.

Related Topics
Copying 
File Menu 
Output Window 
Saving Data to a File 



Setting the Event Forwarding Filter
Set the event forwarding filter to specify for which objects and severity levels a NetWare 
for SAA server sends network events to NetWare for SAA Services Manager.
To set an event forwarding filter, take the following steps. (Supervisor-equivalent 
privileges are required.)

1. In the Active Domain window, select the server whose filter you want to set. 
2. Click the Server Management icon in the Tool Bar.

NetWare for SAA Services Manager opens the Server Management Options 
window. 

3. Specify which objects you want NetWare for SAA Services Manager to monitor by 
selecting them or deselecting them in the Management Options list box. By 
default, all available objects are selected.

4. Specify the filter's severity levels by selecting or clearing the check boxes in the 
Event Forwarding Filter list box. 
If you want the server to forward events of a specific severity level, select that 
level's check box. Otherwise, clear the check box.

5. Save your changes by performing one of the following operations:
Select the Save Selected list to disk check box and click the OK icon.

Perform this operation if you want to save the specified settings to be used 
whenever NetWare for SAA Services Manager is running. 

Clear the Save Selected list to disk check box and then click the OK icon.
Perform this operation if you want your changes to be temporary. If you use this 
procedure, changes made to the severity level check boxes remain effective until 
you exit NetWare for SAA Services Manager.
However, changes made to the objects remain effective until you exit NetWare for 
SAA Services Manager or until an object NetWare for SAA Services Manager can 
manage is installed or loaded on the NetWare for SAA server. If you perform this 
operation and then install or load a manageable object on the NetWare for SAA 
server, the new object will be highlighted even if you removed it in Step 4.

Related Topics
Display and Event Forwarding Filters 
Server Management Options Window 



Setting the Audible Alert
Set the audible alert if you want NetWare for SAA Services Manager to beep whenever it 
receives event messages of a particular severity level.
To set the audible alert, take the following steps:

1. Click the Customize icon in the Tool Bar from the Event Monitor window.
NetWare for SAA Services Manager opens the Customize Events window.

2. Select the Audible Alert check box that matches the severity level of the messages
you want NetWare for SAA Services Manager to notify you of.
Note: If you specify an audible alert for a severity level, you also must specify that
NetWare for SAA Services Manager display events with that severity level.

3. Click the OK icon.
NetWare for SAA Services Manager will save the specified settings so that they are
used the next time NetWare for SAA Services Manager is started.

Related Topic
Customize Events Window 



Setting the Critical Lock
The critical lock affects how NetWare for SAA Services Manager discards critical event 
messages after the Event Monitor window's Event list box is full with only critical event 
messages.
If the critical lock is on, NetWare for SAA Services Manager discards any new message 
including critical event messages and retains all the currently listed critical messages. If 
the critical lock is off, NetWare for SAA Services Manager replaces the oldest critical 
event message with any new message, no matter what severity level the new message 
has.
To turn the critical lock on, select the Critical Lock check box in the Event Monitor 
window.    The default setting is on.
To turn the critical lock off, clear the Critical Lock check box.
Related Topics
Event Monitor Window 
Processing of Network Events 



Setting the Display Filter
The display filter allows you to specify the severity levels for which NetWare for SAA 
Services Manager displays event messages in the Event Monitor window.
To set the display filter, take the following steps:

1. Click the Customize icon in the Tool Bar from the Event Monitor window.
SAA Services Manger opens the Customize Events window.

2. Set the display filter by selecting the Display check boxes that correspond to the 
severity levels of the events for which NetWare for SAA Services Manager is to 
display messages. 

3. Click the OK icon.
NetWare for SAA Services Manager saves the specified settings so that they are 
used the next time NetWare for SAA Services Manager is started.

Related Topics
Customize Events Window 
Display and Event Forwarding Filters 



Specifying the Number of Event Messages
To specify the maximum number of event messages that NetWare for SAA Services 
Manager can monitor at the same time, take the following steps:

1. Click the Customize icon in the Tool Bar from the Event Monitor window.
NetWare for SAA Services Manager opens the Customize Events window.

2. In the Maximum Number of Local Events text box, type the maximum number of 
events that NetWare for SAA Services Manager can monitor at the same time.
You can specify any number from 1 to 500.    The default is 64 messages.

3. Click the OK icon.
NetWare for SAA Services Manager saves the specified settings so that they are 
used the next time NetWare for SAA Services Manager is started.

Related Topic
Customize Events Window 



Turning Off Automatic Scrolling
Automatic scrolling affects how NetWare for SAA Services Manager displays event 
messages while the Event Monitor window's Event list box contains more messages than 
those currently in view.    When automatic scroll in on, any new messages appear at the 
top of the list box and the old messages scroll downward.
To activate the automatic scroll feature, ensure the Stop Scroll check box in the Event 
Monitor window is selected.
Automatic scroll does not affect the Event Monitor window's list box when the list box 
becomes full. When the list box becomes full, NetWare for SAA Services Manager 
automatically scrolls as it discards old messages and displays new messages, depending 
on the critical lock setting.
Related Topic
Event Monitor Window 
Setting the Critical Lock 



Viewing Servers by Icon
To view servers in the Active Domain window by icon, click the View By Icon icon in the 
Tool Bar from the Active Domain window.
Related Topic
Active Domain Window 



Viewing Servers by Name
To view servers in the Active Domain window by name, click the View By Name icon in 
the Tool Bar from the Active Domain window.
Related Topic
Active Domain Window 





 #
3C503 
3C505 
3C523 
802.2 Logical Link 



A
Abort Errors
Active Domain 
Adapter Reset Count 
Adapter Slot 
Adapter Summary Count 
Adapter Type
AppleTalk 
Audit Trail Log File



B
Block ID 
Bus-out Checks 
Bytes Received (SNA) 
Bytes Sent (SNA) 



C
Card Name 
Channel Resets 
Circuit Type 
Command Rejects 
Communication Executive 
Communications Protocols 
Connection Type 
CSCON 
CSDOWN 
CSRESTART 
CSSET 
CSSTATUS 
CTS 
Custom Logical Link 



D
Data Character Size 
Data Checks 
DCE Errors 
Delayed Received Packets 
Delayed Transmit Packets 
Dependent LU 
Destination Address 
Destination Name 
Destination SAP 
DLPI Errors 
Downstream PU 
DTR 
Dynamic Data Exchange (DDE) 



E
Equipment Checks 
Event Log File 
Event Message 
Event Records 
Excessive Collisions 



F
Fatal Retransmissions 
FCS Errors 
First Interrupt Line 
First I/O Address 
First Memory Address 
Frame Aborts 
Frame Lost Errors 



G
There are no entries for this letter.



H
Halt I/Os 
Host Application 
Host Buffer Count 
Host Buffer Size 
Host Destination Address 
Host Link Name 
Host Link Type 
HostPrint Services 



I
IBM 
IBM SDLC 
IBM Token Ring Driver 
Idle Timeouts 
Inactivity Timeouts 
Independent LU 
Interventions Required 



J
There are no glossary terms for this letter.



K
There are no glossary terms for this letter. 



L
LAN 
LCN 
Link Speed 
Link Station Role 
LLC Receive Bytes 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Bytes 
LLC Transmit Errors 
LLC Transmit Packets 
Local DTE Address 
Local SAP Address 
Logic Link Control (LLC) 
Logical Adapter Name 
Logical Unit (LU) 



M
MAC Address 
Managed Domain 
Max LUs 
Media Type 
Microsoft 
Microsoft Excel 
MLID Receive Packets 
MLID Transmit Packets 
MLID Version 
MS Windows 
Mulitcast Packets 
Multidrop Link 



N
Negative Responses Sent 
NetView 
NetWare 
NetWare Communications Security Feature 
NetWare for SAA Service 
NetWare HostPrint Services 
NetWare Loadable Module (NLM) 
NE1000 
NE2000 
NE3200 
NE/2 
NE/2-32 
No ECBs Available 
Non-Productive Timeouts 



O
Outstanding Frames 
Overrun Packets 
Overruns 



P
Physical Unit (PU) 
Print Job 
Printer LU Session 
Promiscuous Packets 
Protocol Stack Name 
PU 
PU ID 
PU 2.0 Sessions 
PU 2.1 Sessions 



Q 
QLLC Logical Link 
Query Name Requests 
Queue Depth 



R
Raw Sends 
Receive Bytes 
Receive Congestion Errors 
Receive Errors 
Remote DTE Address 
Remote Node Type 
Remote SAP 
Reply Timeouts 
Request RUs Received 
Request RUs Sent 
R2_SDLC 
R3_SDLC 



S
SAA 
SDLC Address 
SDLC Encoding 
SDLC Logical Link 
Second I/O Address 
Second Memory Address 
Sequence Number Modulus 
Server Resources 
Server Icon 
Service Description 
Service Name 
Service Profile 
SNA Host Link 
SNA Token Ring Logical Link 
Source Address 
Source SAP 
Specific Name 
Start Time 
Status Message 
Streaming Timeouts 
System Application Architecture (SAA) 



T
Timeout Sends 
Token Errors 
Total Rx Misc Count 
Total Tx Misc Count 
Trace 
Trashed Packets Received 
Transmit Bytes 



U
Underrun Packets 
Underruns 
Up-Active LUs 
Up-Bound LUs 
Up-Inactive LUs 



V
There are    no glossary items for this letter.



W
Write Retries 
Write Timeouts 



X
There are no glossary entries for this letter.



Y
There are no glossary entries for this letter.



Z
There are no glossary entries for this letter.



3C503
Represents a driver that facilitates the communication between a 3C503 adapter and a 
workstation. This is an object NetWare for SAA Services Manager can either manage or 
obtain information about.



3C505
Represents a driver that facilitates the communication between a 3C505 adapter and a 
workstation. This is an object NetWare for SAA Services Manager can either manage or 
obtain information about.



3C523
Represents a driver that facilitates the communication between a 3C523 adapter and a 
workstation. This is an object NetWare for SAA Services Manager can either manage or 
obtain information about.



802.2 Logical Link
Logical end point on an 802.2 link. This is an object NetWare for SAA Services Manager can 
either manage or obtain information about.



Active Domain
The set of communications servers that are available and included in the managed domain. 
This set of servers is displayed in the Active Domain window.



AppleTalk
The protocol used for communications between Apple computers.    AppleTalk is a registered 
trademark of Apple Computer, Inc.



Audit Trail Log File
File in which NetWare for SAA records information that identifies who uses which server 
resources and for how long.



Communication Protocols
Software that determines how data is transported from one computer to another.



CSCON
Utility that configures NetWare for SAA.



CSDOWN
NetWare Communication Services command that brings down the Communication Executive.



CSRESTART
NetWare Communication Services command that restarts the Communication Executive.



CSSET
NetWare Communication Services command that configures NetWare Communication 
Services in Communication Executive v1.2.



CSSTATUS
The NetWare for SAA status utility.



Dynamic Data Exchange (DDE)
 A feature of MS Windows that links data between Windows applications.



Event Log File
File in which a NetWare Communication Services product records network event information.



Event Message
Message describing a network event.



Event Records
Information recorded in an event log file. Event records include a complete event message 
and may also provide a brief explanation of what occurred and a recommended action.



IBM
IBM is a registered trademark of International Business Machines Corporation.



LAN
Local area network.    Computers linked so users can share hard disks, printers, and other 
peripherals.



Logical Link Control (LLC)
Link level control protocol also known as link station.



Logical Unit (LU)
A user port into an SNA network.    LU types 0, 1, 2, 3, 4, and 7 can communicate with host 
applications.    LU type 6.2 can only communicate with other LUs of the same type.



Managed Domain
The set of servers NetWare for SAA Services Manager can manage and monitor. You specify 
this set of servers the first time NetWare for SAA Services Manager is started, but you can 
redefine it at any time.



Microsoft
Microsoft is a registered trademark of Microsoft Corporation.



Microsoft Excel
Microsoft is a registered trademark and Excel is a trademark of Microsoft Corporation.



MS Windows
NetWare for SAA Services Manager requires MS Windows 3.1 or higher. 



NetView
Host-based network management application.    NetView is a registered trademark of 
International Business Machines Corporation.



NetWare
NetWare is a registered trademark of Novell, Inc.



NetWare for SAA Service
A communication service that provides communication between a NetWare local area 
network (LAN) and an IBM System Application Architecture (SAA) environment. SAA is a 
registered trademark of International Business Machines Corporation.



NetWare Loadable Modules (NLM)
A program that provides communication services for NetWare and can be loaded onto a 
server without affecting current server operations.    NetWare Loadable Module and NLM are 
trademarks of Novell, Inc.



Physical Unit (PU)
A node in an SNA network that supports one or more logical units (LUs).



NetWare Communications Security Feature
When this security feature is active, a NetWare for SAA server's users must be valid NetWare
users with permission to use the session they have requested.



Server Icon
The graphic representation of a NetWare for SAA server that NetWare for SAA Services 
Manager is managing. NetWare for SAA Services Manager displays server icons in the Active 
Domain window.



Server Resources
The services, protocols, files, and adapters a NetWare for SAA server manages.



Service Profile
A collection of information about the server's connection to the host and the sessions to be 
obtained through that connection.



Status Message
Messages that indicate NetWare for SAA Services Manager is performing an operation or has
completed an operation or that explain why NetWare for SAA Services Manager cannot 
complete an operation. NetWare for SAA Services Manager displays status messages in the 
message box at the bottom of NetWare for SAA Services Manager windows.



Trace
A record of the SNA data stream between a NetWare for SAA server and an IBM host and 
between a workstation and a NetWare for SAA server.



Abort Errors
Number of times the abort delimiter was transmitted. This delimiter is transmitted if a 
transient error or hard error internal to the ring station is detected or if the third byte of a 
free token is not an ending delimiter.



Adapter Summary Count
Number of errors detected by the SDLC driver.



Adapter Type
Category specified for the adapter in CSCON. The adapter is classified as either Primary or 
Alternate.



Block ID
Unique, three-character, SNA node ID assigned to the physical unit (PU) in CSCON. This is 
the same ID that is assigned to the PU on the host.



Bytes Received
Number of bytes contained in all request units (RUs) received from the host.



Bytes Sent
Number of bytes contained in all request units (RUs) sent to the host.



Command Rejects
For SDLC logical links, this is the number of command rejects (REJ) that were issued to 
request transmission or retransmission of numbered information (I) frames.
For Bus-Tech channel adapters, this is the number of command reject errors that were 
detected on the channel and reported to the mainframe with a unit check status.



DCE Errors
Number of data circuit terminating equipment (DCE) errors.



Destination SAP
The service access point (SAP) used at the destination end of the logical link.



Excessive Collisions
Number of transmissions that were aborted because of excessive collisions on the wire.



Fatal Retransmissions
Number of times there was no response to a FREE BUFFER ENQUIRY after the maximum 
number of retries had been reached.



FCS Errors
Number of errors detected by the frame check sequence (FCS) field.



Frame Aborts
Number of times data was not completely transmitted.



Frame Lost Errors
Number of times the NetWare for SAA server transmitted frames that failed to return to the 
server.



Idle Timeouts
Number of times the protracted idle condition has been detected.



Inactivity Timeouts
Number of timeouts that occurred because bits that did not result in frames were received 
by the logical link control (LLC).



LLC Receive Bytes
Number of in-sequence bytes the logical link control (LLC) received.



LLC Receive Errors
For SDLC logical links, the number of out-of-sequence data frames the logical link control 
(LLC) received.

For SNA token ring logical links, the number of erroneous information (I) frames the logical 
link control (LLC) received.



LLC Receive Packets
Number of packets the logical link control (LLC) received.



LLC Transmit Bytes
Number of bytes the logical link control (LLC) transmitted.



LLC Transmit Errors
For SDLC logical links, the number of data frames the logical link control (LLC) retransmitted.

For SNA token ring logical links, the number of erroneous information (I) frames the logical 
link control (LLC) transmitted.



LLC Transmit Packets
For SDLC logical links, the number of data frames the logical link control (LLC) transmitted.

For SNA token ring logical links, the number of packets the logical link control (LLC) 
transmitted.



MLID Receive Packets
Number of packets received by the Multiple Link Interface Driver (MLID).



MLID Transmit Packets
Number of packets transmitted by the Multiple Link Interface Driver (MLID).



Multicast Packets
Number of packets that have multidestination addresses, which are associated with one or 
more stations on a given network.



Negative Responses Sent
Number of negative responses sent to the host.



Non-Productive Timeouts
Number of timeouts that occurred because the SDLC driver received bits that did not result 
in frames.



Outstanding Frames
Number of frames not yet acknowledged by the remote link station to which they were 
transmitted.



Overrun Packets
Number of packets the Network Interface Controller (NIC) could not accept because the 
receive buffers were unavailable.



Overruns
For SDLC logical links, the number of times a new frame was received before the previous 
frame was completely processed.
For Bus-Tech channel adapters, the number of data overrun errors detected on the channel 
and reported to the mainframe with a unit check status.



Promiscuous Packets
Number of packets the Network Interface Controller (NIC) received because the adapter is in 
a promiscuous mode to receive all packets with a physical address.



PU ID
Unique, five-character, SNA node ID that is defined when NetWare for SAA is configured in 
CSCON. This is the same ID that is assigned to that SNA node on the host.



Query Name Requests
Number of requests to query sent to a general or specific port name.



Raw Sends
Number of packets the protocol stack formatted.



Receive Congestion Errors
Number of times packets were discarded because no more buffers were available.



Receive Errors
Number of times packets were discarded because a receive error [such as cyclical 
redundancy check (CRC) or frame alignment] was detected.



Reply Timeouts
Number of times a remote station failed to respond to a link station's command poll.



Request RUs Received
Number of request units (RUs) received from the host.



Request RUs Sent
Number of request units (RUs) sent to the host.



SDLC Encoding
Indicates whether the data is encoded for NRZ or NRZI. (No value is listed for token ring 
connections.)



Source SAP
The service access point (SAP) used at the local end of the logical link.



Timeout Sends
Number of times a transmit packet times out waiting for a workstation to acknowledge a 
FREE BUFFER ENQUIRY.



Token Errors
Number of errors that required a token to be transmitted. These errors indicate that there is 
a circulating priority token, a circulating frame, or a lost frame or token.



Trashed Packets Received
Number of malformed packets the NetWare for SAA server received.



Underrun Packets
Number of packets not sent because the Network Interface Controller (NIC) could not access 
the bus before the first in first out (FIFO) queue was empty.



Underruns
Number of times data was not completely transmitted because the data was not available.



Up-Active LUs
Number of active LUs not yet bound to an application.



Up-Bound LUs
Number of active LUs that have received a BIND command, which provides access to an 
application.



Up-Inactive LUs
Number of LUs the host has not yet activated.



Write Retries
Number of retransmissions of SDLC information (I) packets. The value of this attribute will 
always be 0.



Write Timeouts
Number of timeouts that occurred during write operations. The value of this attribute will 
always be 0.



Adapter Slot
Number of the slot in which the board is installed.



Card Name
Name assigned to the LAN adapter by its manufacturer.



Circuit Type
Type of circuit being used. The possible values for this field are SVC (switched virtual circuit) 
or PVC (permanent virtual circuit).



Connection Type
Type of SDLC connection (switched or non-switched) established between the host and the 
NetWare for SAA server.



CTS
Number of Clear-to-Send (CTS) signals detected.



Data Character Size
Length of character transmitted through the port. This size can be 5, 6, 7, or 8 bits.



Destination Address
The media access control (MAC) address of the remote node.



Destination Name
The remote address as required by the custom protocol stack. This is the entry specified in 
CSCON's Data Link Custom Data field.



DTR
Number of Data Terminal Ready signals detected.



First Interrupt Line
The primary interrupt vector number.



First I/O Address
The absolute primary base I/O port for the adapter.



First Memory Address
The adapter's absolute primary memory address.



Host Destination Address
Address of the host destination node.



Host Link Name
The service profile name the NetWare Communication Services administrator assigned to 
the host in CSCON.



Host Link Type
Type of connection [SDLC, QLLC, or ITRN (IBM Token Ring)] established between the host and
the NetWare for SAA server. 



LCN
The logical channel number assigned to a virtual circuit. A logical channel is a 
communication path between two X.25 nodes.



Link Speed
Link speed the adapter supports.



Link Station Role
The NetWare for SAA server's role, which is either primary, secondary, or negotiable.



Local SAP Address
The service access point (SAP) used at the local end of the logical link.



Local DTE Address
The Data Terminal Equipment (DTE) address that other nodes on an X.25 network use to 
transmit frames to or receive frames from the local node.



Logical Adapter Name
Name that the NetWare Communication Services administrator assigns to the SNA, 802.2, 
QLLC, SDLC, or custom adapter in CSCON.



MAC Address
Media access control address of a LAN station. (Not applicable to an SDLC adapter.)



Max LUs
Maximum number of LUs for which the NetWare for SAA server is configured.



Media Type
Type of physical connection (token ring, Ethernet, SDLC, ARCnet, or X.25).



MLID Version
Major and minor version numbers of the MLID.



Multidrop Link
Indicates whether NetWare for SAA is a station on a multi-drop link.



Protocol Stack Name
Name of the protocol stack NetWare Loadable Module (NLM). (The name of custom protocol 
stack NLMs can be assigned in CSCON.)



Remote DTE Address
The Data Terminal Equipment (DTE) address of the remote node.



Remote Node Type
The SNA node type of the computer to which the NetWare for SAA server is sending 
information. Peripheral Node Type 2.1 in this field indicates the remote node is an SNA 
peripheral node with a peer-to-peer connection. Subarea Node Type 4 in this field indicates 
the remote node is a controller. Subarea Node Type 5 in this field indicates the remote node 
is a host.



Remote SAP
The service access point (SAP) used at the remote end of the logical link.



SDLC Address
The SDLC station address currently in use.



Second I/O Address
The absolute secondary base I/O port for the adapter.



Second Memory Address
The adapter's absolute secondary memory address.



Service Name
The name the NetWare Communication Services administrator assigned to the 
communication service in CSCON.



Sequence Number Modulus
Maximum number of frames the NetWare for SAA server can send before it waits for the 
remote node to send an RR (Receive Ready).



Source Address
The media access control (MAC) address of the local adapter.



Specific Name
The specific name assigned to the port by the NetWare Communication Services 
administrator. This is a unique name users can specify to access the port.



NE/2
Represents a driver that establishes an Ethernet connection between a workstation and a 
NetWare for SAA server. (NE/2 is a trademark of Novell, Inc.) This is an object NetWare for 
SAA Services Manager can either manage or obtain information about.



Custom Logical Link
Logical end point on a custom-protocol link. This is an object NetWare for SAA Services 
Manager can either manage or obtain information about.



Communication Executive
A set of NetWare Loadable Modules (NLMs) that supplies tracing, security, connectivity, 
network management, and other NetWare for SAA services. This is an object NetWare for 
SAA Services Manager can either manage or obtain information about.



IBM_SDLC
Driver that helps establish an SDLC host link between IBM equipment and NetWare for SAA. 
This is an object NetWare for SAA Services Manager can either manage or obtain information
about.



IBM Token Ring Driver
Driver that facilitates communication between an IBM Token Ring adapter and NetWare 
Communication Services. This is an object NetWare for SAA Services Manager can either 
manage or obtain information about.



NE/2-32
Represents a driver that establishes an Ethernet connection between a workstation and a 
NetWare for SAA server. (NE/2-32 is a trademark of Novell, Inc.) This is an object NetWare for
SAA Services Manager can either manage or obtain information about.



NE1000
Represents a driver that establishes an Ethernet connection between a workstation and a 
NetWare for AAA server. (NE1000 is a trademark of Novell, Inc.) This is an object NetWare for
SAA Services Manager can either manage or obtain information about.



NE2000
Represents a driver that establishes an Ethernet connection between a workstation and a 
NetWare for SAA server. (NE2000 is a trademark of Novell, Inc.) This is an object NetWare for
SAA Services Manager can either manage or obtain information about.



NE3200
Represents a driver that establishes an Ethernet connection between a workstation and a 
NetWare for SAA server. (NE3200 is a trademark of Novell, Inc.) This is an object NetWare for
SAA Services Manager can either manage or obtain information about.



NW 386 OS
NetWare operating system. This is an object NetWare for SAA Services Manager can either 
manage and obtain information about.



NetWare for SAA Service
A communication service that provides communication between a NetWare local area 
network (LAN) and an IBM System Application Architecture (SAA) environment. SAA is a 
registered trademark of International Business Machines Corporation. This is an object 
NetWare for SAA Services Manager can either manage and obtain information about.



QLLC Logical Link
Logical end point on a QLLC link. This is an object NetWare for SAA Services Manager can 
either manage or obtain information about.



R2_SDLC
Driver that helps establish an SDLC host link between IBM equipment and NetWare for SAA. 
This is an object NetWare for SAA Services Manager can either manage or obtain information
about.



R3_SDLC
Driver that helps establish an SDLC host link between IBM equipment and NetWare for SAA. 
This is an object NetWare for SAA Services Manager can either manage or obtain information
about.



SDLC Logical Link
Logical end point on an SDLC link. This is an object NetWare for SAA Services Manager can 
either manage or obtain information about.



SNA Host Link
Logical link between a NetWare for SAA server and the host.    This is an object NetWare for 
SAA Services Manager can either manage or obtain information about.



PU 2.0 Sessions
SNA LU x, 1, 2, or downstream physical unit (PU). These are objects NetWare for SAA 
Services Manager can either manage or obtain information about.



PU 2.1 Sessions
SNA LU6.2 sessions. This is an object NetWare for SAA Services Manager can either manage 
or obtain information about.



SNA Token Ring Logical Link
Logical end point on a token ring logical link. This is an object NetWare for SAA Services 
Manager can either manage or obtain information about.



No ECBs Available
Number of times the adapter was unable to allocate a buffer during its first attempt.



Total Tx Misc Count
Number of errors detected while transmitting to the channel.



Total Rx Misc Count
Number of errors detected while receiving from the channel.



Transmit Bytes
Number of bytes transmitted to the channel (low order).



Receive Bytes
Number of bytes received from the channel (low order).



Adapter Reset Count
Number of times the adapter was reset.



Queue Depth
Number of packets waiting to be transmitted to the channel.



Halt I/Os
Number of halt I/Os detected on the channel.



Streaming Timeouts
Number of times a channel data transfer encountered a streaming timeout.



Channel Resets
Number of system resets detected on the channel.



Interventions Required
Number of intervention-required errors detected on the channel and reported to the 
mainframe with a unit check status.



Bus-out Checks
Number of bus-out check errors detected on the channel and reported to the mainframe 
with a unit check status.



Equipment Checks
Number of equipment check errors detected on the channel and reported to the mainframe 
with a unit check status.



Data Checks
Number of data check errors detected on the channel and reported to the mainframe with a 
unit check status.



DLPI Errors
Number of errors detected in the protocol between the adapter driver and NetWare for SAA.



Delayed Transmit Packets
Number of packets received from the channel that were delayed momentarily because of a 
flow control condition in the channel adapter.



Delayed Received Packets
Number of packets received from the channel that were delayed momentarily because of a 
flow control condition in NetWare for SAA.



Host Buffer Count
Number of buffers provided by the mainframe in each CCW chain.



Host Buffer Size
Size of each mainframe buffer.



Start Time
Date and time the service profile was loaded.



Service Description
Full name of the SAA service for which the profile is configured.



Downstream PU
A physical unit (PU) located downstream from a VTAM host.    In the NetWare for SAA 
environment, a downstream PU is further downstream than the NetWare for SAA server.    
NetWare for SAA has the ability to pass dependent logical unit (LU) traffic to these 
downstream PUs.    The downstream PUs are transparent to the host -- it sees only the 
NetWare for SAA server. 



Dependent LU
A logical unit (LU) that is dependent upon a connection to a host and is activated and 
controlled by a system services control point (SSCP) in order to engage a session.



Independent LU
A logical unit (LU) that is not dependent upon a connection to a host.    It allows 
communication with anything running APPC, whether it is an upstream system such as an 
AS/400, or another server running NetWare for SAA.



System Application Architecture (SAA)
An application architecture used to develop application programs for the IBM Systems 
Network Architecture (SNA) environment.    SAA is a registered trademark of International 
Business Machines Corporation.





Active and Managed Domains
When you access the Change Managed Domain window, NetWare for SAA Services 
Manager displays a list of the available NetWare    for SAA servers attached to the 
network from the server specified by the PREFERREDBINDERY parameter.    You define 
which servers (available and unavailable) you want NetWare for SAA Services Manager to
manage and monitor.    This list of servers to be managed is called the managed domain.
The active domain contains all the currently active NetWare for SAA servers in the 
managed domain.    In addition, servers that become active after NetWare for SAA 
Services Manager is started are added to the active domain. Servers that become 
unavailable or removed from the managed domain after NetWare for SAA Services 
Manager is started are removed from the active domain.
Related Topics
Adding Servers
Active Domain Window 
Redefining the Managed Domain
Removing Servers



Commands
NetWare for SAA Services Manager provides a Menu Bar as a way of invoking commands.
To invoke a command, make the desired window active and select a command from the 
Menu Bar.    You can also access NetWare for SAA Services Manager functions by 
selecting a server and clicking an icon in the Tool Bar. 

Related Topics
Commands 
Menus 
Icons



Configuration Attributes
NetWare for SAA Services Manager allows you to obtain configuration data for the 
following objects:
802.2 Logical LinkConfiguration Attributes 
Adapter Configuration Attributes 
Custom Logical Link Configuration Attributes 
QLLC Logical Link Configuration Attributes 
SDLC Logical Link Configuration Attributes 
Service Profile Configuration Attributes 
SNA Host Link v1.2 Configuration Attributes 
SNA Host Link v1.3 Configuration Attributes 
Related Topics
Adapter Configuration Window 
Obtaining Configuration Data
Logical Link Configuration Window 
Service Profile Configuration Window 
SNA Host Link Configuration Window 



802.2 Logical Link Configuration Attributes
Destination Address 
Host Link Name 
Link Station Role 
Local SAP 
Logical Adapter Name 
Media Type 
Protocol Stack Name 
Remote Node Type 
Remote SAP 
Sequence Number Modulus 
Service Name 
Source Address 



Destination Address
Media access control (MAC) address of the remote node.



Host Link Name
Service profile name assigned in CSCON.



Link Station Role
Primary, secondary, or negotiable server role.



Local SAP
Service access point (SAP) used at the local end of the logical link.



Logical Adapter Name
Name assigned to the 802.2 adapter in CSCON.



Media Type
Type of physical connection.



Protocol Stack Name
Name of the protocol stack NetWare Loadable Module (NLM).



Remote Node Type
SNA node type to which the server is sending information.



Remote SAP
Services access point (SAP) used at the remote end of the logical link.



Sequence Number Modulus
Maximum number of frames the server can send before it waits for the remote node to 
send a Receive Ready (RR).



Service Name
Name assigned to the communication service in CSCON.



Source Address
Media access control (MAC) address of the local adapter.



Adapter Configuration Attributes
Adapter Slot 
Card Name 
First Interrupt Line 
First I/O Address 
First Memory Address 
Link Speed 
MAC Address 
Media Type 
MLID Version 
Second I/O Address 
Second Memory Address 



Adapter Slot
Number of the slot in which the board is installed.



Card Name
Name assigned to the adapter by the manufacturer.



First Interrupt Line
Primary interrupt vector number.



First I/O Address
Absolute primary base I/O port for the adapter.



First Memory Address
Absolute primary memory address.



Link Speed
Link speed the adapter supports. MSB=1 indicates Kbps; MSB=0 indicates Mbps.



MAC Address
Media access control (MAC) address of a LAN station.



MLID Version
Major and minor version numbers of the multiple link interface driver (MLID).



Second I/O Address
Absolute secondary base I/O port for the adapter.



Second Memory Address
Absolute secondary memory address.



Custom Logical Link Configuration Attributes
Host Link Name 
Link Station Role 
Logical Adapter Name 
Media Type 
Protocol Stack Name 
Remote DTE Address 
Remote Node Type 
Service Name 



Remote DTE Address
Remote node address required by the custom protocol stack. This is the entry specified 
in CSCON's Data Link Custom Data field.



QLLC Logical Link Configuration Attributes
Circuit Type 
Host Link Name 
Link Station Role 
Local DTE Address 
Logical Adapter Name 
Logical Channel Number (LCN) 
Media Type 
Protocol Stack Name 
Remote DTE Address 
Remote Node Type 
Service Name 



Circuit Type
Type of circuit used, switched virtual circuit (SVC) or permanent virtual circuit (PVC).



Logical Channel Number
Logical channel number assigned to a virtual circuit. A logical channel is a 
communication path between two X.25 nodes.



Local DTE Address
Data terminal equipment (DTE) address that other X.25 nodes use to transmit and 
receive frames.



SDLC Logical Link Configuration Attributes
Connection Type 
Duplex Mode 
Host Link Name 
Link Station Role 
Logical Adapter Name 
Media Type 
Multidrop Link 
Protocol Stack Name 
Remote Node Type 
SDLC Address 
Sequence Number Modulus 
Service Name 



Connection Type
Type of SDLC connection (switched or nonswitched) established between the host and 
the server.



Duplex Mode
Data transmission mode (half duplex or full duplex).



Multidrop Link
Indicates (yes/no) whether NetWare for SAA is a station on a multidrop link.



SDLC Address
SDLC station address currently in use.



Service Profile Configuration Attributes
Service Description 
Service Name 
Start Time 
Version 



Service Description
Full name of the SAA service for which the profile is configured. (NetWare for SAA v1.3 
only)



Service Name
Name of the service profile.



Start Time
Date and time the service profile was loaded.



Version
Version number of the SAA service for which the profile is configured.



SNA Host Link v1.2 Configuration Attributes
Host Link Type 
Max LUs 



Host Link Type
Type of connection (SDLC, QLLC, or ITRN (IBM Token Ring)) established between the host 
and the server.



Max LUs
Maximum number of dependent LUs your copy of NetWare for SAA can support. For 
dependent LUs, this is also the maximum number of sessions.



SNA Host Link v1.3 Configuration Attributes
Adapter Type 
Block ID 
Destination SAP 
Host Destination Address 
Host Link Type 
Link Station Role 
Logical Adapter Name 
Max LUs 
Physical Unit (PU) ID 
Protocol Stack Name 
SDLC Encoding 
Source SAP 



Adapter Type
Adapter category specified in CSCON. Categories are either primary or alternate.



Block ID
Unique, three-character SNA node ID assigned to the physical unit (PU) in CSCON. This is 
the same ID assigned to that PU on the host.



Destination SAP
Service access point (SAP) used at the destination end of the logical link.



Host Destination Address
Address of the host destination node.



Physical Unit (PU) ID
Unique, five-character SNA node ID defined when NetWare for SAA is configured in 
CSCON. This is the same ID assigned to the SNA node on the host.



SDLC Encoding
Indicator    to determine what other data is encoded for NRZ or NRZI. (No value is listed 
for token ring connections.



Source SAP
Service access point (SAP) used at the local end of the logical link.



Display and Event Forwarding Filters
NetWare for SAA Services Manager enables you to customize for which objects and 
severity levels event messages are forwarded to and displayed in the Event Monitor 
window.    You use the display filter to determine for which severity levels NetWare for 
SAA Services Manager will display network events.    You use the event forwarding filter 
to determine for which objects and severity levels a server forwards events to NetWare 
for SAA Services Manager.

Display filter
This filter determines whether NetWare for SAA Services Manager displays a 
forwarded event message. From the Customize Events window, you select the 
severity levels of the events you want NetWare for SAA Services Manager to 
display in the Event Monitor's list box. If an event message is forwarded to 
NetWare for SAA Services Manager and the event severity does not match one of 
the selected severity levels, NetWare for SAA Services Manager does not notify 
you of the event.

Event Forwarding filter
From the Server Management Options window, this filter specifies for which 
objects and severity levels a server forwards messages to NetWare for SAA 
Services Manager.    The objects you can include in a NetWare for SAA server's 
event forwarding filter depend on that server's hardware and software, and are 
listed below.

802.2 Logical Link 
Communication Executive
Custom Logical Link
IBM Token Ring Driver
NetWare for SAA Service
QLLC Logical Link
SDLC Logical Link
SNA Host Link
SNA Token Ring Logical Link

Related Topics
Processing of Network Events
Setting the Event Forwarding Filter 
Setting the Display Filter
Severity Levels 



Graphic Display of Statistical Data
NetWare for SAA Services Manager allows you to display statistical data in graphs or pie 
charts. You can display statistical data for SNA Host Link service component, PU 2.0 
Sessions, PU 2.1 Sessions, adapters, and LLC protocols (logical links). NetWare for SAA 
Services Manager allows you to specify the statistical attributes to graph and the graphic
display options.    You display statistical data by selecting an object or service component 
in the Server Status window and clicking the Graph icon or Pie icon.

Related Topics
Collecting and Displaying Statistics 
Graph Setting Window 
Graph Statistics Window 
Pie Settings Window 
Pie Statistics Window 
Server Status Window 
Statistical Attributes 



NetWare for SAA Link Management
NetWare for SAA Services Manager allows you to collect and display statistical and 
configuration data for the physical units (PUs), logical link (LLC) protocols (logical links), 
and adapters used for the SAA links on the NetWare for SAA server you are managing. 
This allows you to monitor and evaluate the performance of your NetWare for SAA links 
through the following data:

Statistics and configuration data for PU 2.0 connections
LLC protocol (logical link) statistics and configuration data for the logical link sublayer

functions
Adapter statistics and configuration data for the media access control (MAC) sublayer

functions
This data can help you establish performance standards for the NetWare for SAA server 
links and can assist you in narrowing the scope and cause of connection problems.

Related Topics
Collecting and Displaying Statistical Data 
Configuration Attributes 
Obtaining Configuration Data 
Statistical Attributes 



Objects That Provide Information
Whenever NetWare for SAA Services Manager is monitoring network events, managing 
NetWare for SAA servers or their resources, or accessing a server's log files, it obtains 
information from the following objects.
3C503 
3C505 
3C523 
802.2 Logical Link 
Communication Executive
Custom Logical Link
IBM_SDLC
IBM Token Ring Driver
NE/2 
NE/2-32
NE1000
NE2000
NE3200
NetWare for SAA Service
PU 2.0 Sessions
PU 2.1 Sessions
QLLC Logical Link
R2_SDLC
R3_SDLC
SDLC Logical Link
SNA Host Link
SNA Token Ring Logical Link



Processing of Network Events
NetWare for SAA Services Manager processes network events in the following manner:

A NetWare for SAA server detects an event.
A NetWare for SAA server uses the event forwarding filter to determine whether the 

event message is forwarded to NetWare for SAA Services Manager.    If the event 
forwarding filter is set for the related object and severity level, the server forwards
the event to NetWare for SAA Services Manager.    Otherwise, the message is not 
forwarded.

When NetWare for SAA Services Manager receives an event message, it checks its    
display filter to determine whether to display the event message.    If the display filter is set 
for the related severity level, NetWare for SAA Services Manager displays the event message
in the Event Monitor window.    Otherwise, it is not displayed.

If the server's Event Log State setting is on, event messages are logged in the server's 
event log file independently of the event forwarding filter and display filter settings.
Related Topics
Display and Event Forwarding Filters 
Event Monitor Window 
Setting the Critical Lock 
Setting the Display Filter
Setting the Event Forwarding Filter 
Severity Levels 



Severity Levels
The following table describes the various severity levels of network events. Levels are 
presented in the order of their severity. 

Severit
y Level

Description

Critical Indicates a managed 
object is out of service. 
Respond to critical events
immediately.

Major Indicates performance 
degradation of a 
managed object. It is 
urgent that you respond 
to major events.

Minor Indicates problems that 
do not seriously affect a 
managed object's service
or operation. Respond to 
minor events as soon as 
possible.

Warning Indicates a potential 
problem has been 
detected before there are
any noticeable effects. 
Respond to warning 
events as soon as 
possible to prevent them 
from affecting a managed
object.

Informat
ional

Does not indicate a 
problem but provides 
status or other data you 
may want to know about.
You need not respond to 
informational events.

Indeter
minate

Indicates NetWare for 
SAA Services Manager 
could not assess the 
impact of the event. 
Examine indeterminate 
events to determine 
whether any action is 
necessary.

Related Topics
Processing of Network Events
Setting the Critical Lock



Severity Level Colors



Severity Level Colors
To help you quickly identify the severity level of network events, NetWare for SAA 
Services Manager can display event messages and server icons in the following severity 
level colors:

Color Severity Level

Red Critical

Brown Major

Yellow Minor

Magenta Warning

Green Informational and 
Indeterminate

Related Topics
Displaying Event Messages in Color
Displaying Server Icons In Color 
Severity Levels 



Statistical Attributes
NetWare for SAA Services Manager enables you to collect and display statistical 
attributes for the following adapters, host links, and logical links.
802.2 Logical Link Statistical Attributes 
Bus-Tech Channel Adapter Statistical Attributes 
Custom Logical Link Statistical Attributes 
Ethernet Adapter Statistical Attributes 
Other Adapter Statistical Attributes 
QLLC Logical Link Statistical Attributes 
SDLC Adapter Statistical Attributes 
SDLC Logical Link Statistical Attribures v1.2 
SDLC Logical Link Statistical Attributes v1.3 
SNA Host Link Statistical Attributes 
SNA Token Ring Logical Link Statistical Attributes 
Token Ring Adapter Statistical Attributes 
Related Topics
Collecting and Displaying Statistical Data 
Graph Setting Window 
Graph Statistics Window 
NetWare for SAA Link Management 
Pie Settings Window 
Pie Statistics Window 



802.2 Logical Link Statistical Attributes
LLC Receive Bytes 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Bytes 
LLC Transmit Errors 
LLC Transmit Packets 
Outstanding Frames 
Reply Timeouts 



LLC Receive Bytes
Number of in-sequence bytes the LLC received.



LLC Receive Errors
Number of out-of-sequence data frames the LLC received.



LLC Receive Packets
Number of in-sequence data frames the LLC received.



LLC Transmit Bytes
Number of bytes the LLC transmitted.



LLC Transmit Errors
Number of data frames the LLC retransmitted.



LLC Transmit Packets
Number of data frames the LLC transmitted.



Outstanding Frames
Number of frames not yet acknowledged by the remote logical link that they were 
transmitted to.



Reply Timeouts
Number of times a remote station failed to respond to a logical link's command poll.



Bus-Tech Channel Adapter Statistical Attributes
Adapter Reset Count 
Bus-out Checks 
Channel Resets 
Command Rejects 
Data Checks 
Delayed Received Packets 
Delayed Transmit Packets 
DLPI Errors 
Equipment Checks 
Halt I/Os 
Host Buffer Count 
Host Buffer Size 
Interventions Required 
MLID Receive Packets 
MLID Transmit Packets 
No ECBs Available 
Overruns 
Queue Depth 
Receive Bytes 
Streaming Timeouts 
Total Rx Misc Count 
Total Tx Misc Count 
Transmit Bytes 



Adapter Reset Count
Number of times the adapter was reset.



Bus-out Checks
Number of bus-out check errors detected on the channel and reported to the host with a 
unit check status.



Channel Resets
Number of system resets detected on the channel.



Command Rejects
Number of command reject errors detected on the channel and reported to the host with 
a unit check status.



Data Checks
Number of data check errors detected on the channel and reported to the host with a 
unit check status.



Delayed Received Packets
Number of packets received from the channel that were delayed because of a flow 
control condition in the channel adapter.



Delayed Transmit Packets
Number of packets transmitted to the channel that were delayed because of a flow 
control condition in the channel adapter.



DLPI Errors
Number of errors detected in the protocol between the adapter driver and NetWare for 
SAA.



Equipment Checks
Number of equipment check errors detected on the channel and reported to the host 
with a unit check status.



Halt I/Os
Number of halt I/Os detected on the channel.



Host Buffer Count
Number of buffers provided by the host in each CCW chain.



Host Buffer Size
Size of each host buffer.



Interventions Required
Number of intervention required errors detected on the channel and reported to the host 
with a unit check status.



MLID Receive Packets
Number of packets received from the channel.



MLID Transmit Packets
Number of packets transmitted to the channel.



No ECBs Available
Number of times the adapter was unable to allocate a buffer during its first attempt.



Overruns
Number of data overrun errors detected on the channel and reported to the host with a 
unit check status.



Queue Depth
Number of packets waiting to be transmitted to the channel.



Receive Bytes
Number of bytes received from the channel (low order).



Streaming Timeouts
Number of times a channel data transfer encountered a streaming timeout.



Total Rx Misc Count
Number of errors detected while receiving from the channel.



Total Tx Misc Count
Number of errors detected while transmitting to the channel.



Transmit Bytes
Number of bytes transmitted to the channel (low order).



Custom Logical Link Statistical Attributes
LLC Receive Bytes 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Bytes 
LLC Transmit Errors 
LLC Transmit Packets 



Ethernet Adapter Statistical Attributes
Excessive Collisions 
MLID Receive Packets 
MLID Transmit Packets 
Multicast Packets 
Overrun Packets 
Promiscuous Packets 
Receive Errors 
Trashed Packets Received 
Underrun Packets 



Excessive Collisions
Number of transmissions aborted because of excessive collisions.



MLID Receive Packets
Number of packets received by the multiple link interface drvier (MLID).



MLID Transmit Packets
Number of packets transmitted by the multiple link interface driver (MLID).



Multicast Packets
Number of packets with multidestination addresses, which are associated with one or 
more stations on a given network.



Overrun Packets
Number of packets the Network Interface Controller (NIC) could not accept because the 
receive buffers were all unavailable.



Promiscuous Packets
Number of packets the Network Interface Controller (NIC) received because the adapter 
is in a promiscuous mode to receive all packets with a physical address.



Receive Errors
Number of times packets were discarded because a receive error (such as cyclical 
redundancy check (CRC) or frame alignment) was detected.



Trashed Packets Received
Number of malformed packets the server received.



Underrun Packets
Number of packets not sent because the Network Interface Controller (NIC) could not 
access the bus before the first-in-first-out (FIFO) was empty.



Other Adapter Statistical Attributes
MLID Receive Packets 
MLID Transmit Packets 
Receive Congestion Error 



Receive Congestion Errors
Number of times packets were discarded because no more buffers were available.



QLLC Logical Link Statistical Attributes
LLC Receive Bytes 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Bytes 
LLC Transmit Errors 
LLC Transmit Packets 



SDLC Adapter Statistical Attributes
MLID Receive Packets 
MLID Transmit Packets 



SDLC Logical Link Statistical Attributes v1.2
Adapter Summary Count 
Command Rejects 
Connection Retries 
DCE Errors 
FCS Errors 
Frame Aborts 
Idle Timeouts 
LLC Receive Packets 
LLC Transmit Packets 
Non-Productive Timeouts 
Overruns 
Underruns 
Write Retries 
Write Timeouts 



Adapter Summary Count
Number of errors detected by the SDLC driver.



Command Rejects
Number of command rejects (REJ) issued to request transmission or retransmission of 
numbered information (I) frames.



Connection Retries
Number of connection problems, such as loss of carrier. The value of this attribute is 
always 0.



DCE Errors
Number of data circuit terminating equipment (DCE) errors.



FCS Errors
Number of errors detected by the FCS field.



Frame Aborts
Number of times data was not completely transmitted.



Idle Timeouts
Number of times the protracted idle condition was detected.



Non-Productive Timeouts
Number of timeouts that occurred because the SDLC driver received bits that did not 
result in frames.



Overruns
Number of times a new frame was received before the previous frame was completely 
processed.



Underruns
Number of times data was not completely transmitted because the data was not 
available.



Write Retries
Number of retransmissions of SDLC information (I) packets. The value of this attribute is 
always 0.



Write Timeouts
Number of timeouts that occurred during write operations. The value of this attribute is 
always 0.



SDLC Logical Link Statistical Attributes v1.3
Command Rejects 
Connection Retries 
DCE Errors 
FCS Errors 
Frame Aborts 
Idle Timeouts 
LLC Receive Bytes 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Bytes 
LLC Transmit Errors 
LLC Transmit Packets 
Non-Productive Timeouts 
Outstanding Frames 
Overruns 
Reply Timeouts 
Underruns 
Write Retries 
Write Timeouts 



SNA Host Link Statistical Attributes
Bytes Received 
Bytes Sent 
Negative Responses Sent 
Request RUs Received 
Request RUs Sent 
Up-Active LUs 
Up-Bound LUs 
Up-Inactive LUs 



Bytes Received
Number of bytes contained in all request units (RUs) received from the host.



Bytes Sent
Number of bytes contained in all RUs sent to the host.



Negative Responses Sent
Number of negative responses sent to the host.



Request RUs Received
Number of request units (RUs) received from the host.



Request RUs Sent
Number of request units (RUs) sent to the host.



Up-Active LUs
Number of active LUs not yet bound to an application.



Up-Bound LUs
Number of LUs that have received a BIND command, which provides access to an 
application.



Up-Inactive LUs
Number of LUs that the host has not yet activated.



SNA Token Ring Logical Link Statistical Attributes
Inactivity Timeouts 
LLC Receive Errors 
LLC Receive Packets 
LLC Transmit Errors 
LLC Transmit Packets 



Inactivity Timeouts
Number of timeouts that occurred because bits that did not result in frames were 
received by the LLC. 



Token Ring Adapter Statistical Attributes
Abort Errors 
Frame Lost Errors 
MLID Receive Packets 
MLID Transmit Packets 
Receive Congestion Errors 
Token Errors 



Abort Errors
Number of times the abort delimiter was transmitted. This delimiter is transmitted if a 
transient error or hard error internal to the ring station is detected or if the third byte of a
free token is not an ending delimiter.



Frame Lost Errors
Number of times the server transmitted frames that failed to return to the server.



Token Errors
Number of errors that required a token to be transmitted. These errors indicate that 
there is a circulating priority token, a circulating frame, or a lost frame or token.



What Is NetWare for SAA Services Manager?
NetWare for SAA Services Manager is network management software that allows you to

Monitor and manage NetWare for SAA servers and NetWare for SAA services over 
Novell LANs and WANs

Load, unload, and restart NetWare for SAA service profiles
Load and unload NLM files and protocols
Display and control host link (PU 2.0) sessions for LU types 0, 1, 2, and 3
Start and stop a trace on a host link (PU 2.0) session
Lock and unlock LUs
Display LU6.2 session data
Obtain and display configuration data for SNA Host Links, logical links, and adapters
Collect and graphically display statistical data for SNA Host Links, logical links, and 

adapters
Dynamically change server management options
Customize the display of real-time notification of network events
Control, through an event forwarding filter, which events a NetWare for SAA server 

forwards to NetWare for SAA Services Manager
Link data to other Windows applications through Dynamic Data Exchange (DDE).
Access a NetWare for SAA server event log file and audit trail log file.
Print, save, and copy NetWare for SAA Services Manager information
Access online help for each NetWare for SAA Services Manager window and other 

important product information
Related Topics
Accessing Audit Trail Log File 
Accessing Event Log File Through the Event Monitor Window 
Accessing Event Log File Through the Server Management Options Window 
Changing Server Management Options 
Collecting and Displaying Statistical Data
Controlling Sessions
Copying
Displaying Host Link Dependent Data 
Displaying Session Information for LU6.2
Event Monitor Window 
Loading and Unloading NLMs or Protocols in v1.3
Loading and Unloading Protocols in v1.2
Loading, Unloading, or Restarting Services
Obtaining Configuration Data
Obtaining User Information
Printing
Running SNA Traces
Saving Data to a File
Saving Data to the Windows Clipboard 





About NetWare for SAA Services Manager

Displays version and product information along with the percentage of memory used 
(<Alt><H><A>).
Related Topics
Displaying the Percentage of Memory Used 
Help Menu 



Alarms Command

Accesses the Help file for NetWare for SAA Services Manager alarms or event messages 
(<Alt> <H> <L>).
Related Topics
Commands Command 
Glossary Command 
Index Command 
Overview Command 
Procedures Command 



Arrange Icons Command
Arranges the server icons of the Active Domain window in rows. This command is 
particularly useful when you need to display many server icons in the Active Domain 
window.    You choose Arrange Icons from the Window menu (<Alt> <W> <A>).
Related Topics
Active Domain Window 
Cascade Command 
Tile Command 



Cascade Command

Arranges all open windows one in front of the other.
You choose Cascade from the Window menu (<Alt> <W> <C>).
Related Topics
Arrange Icons Command 
Tile Command 



Close All Command

Closes all NetWare for SAA Services Manager windows open at the time you choose the 
command <Alt> <W> <L>. However, this command does not close the Active Domain 
window. The Active Domain window must remain open while you are running NetWare for
SAA Services Manager.
Related Topic
Exiting NetWare for SAA Services Manager 



Commands Command

Opens the Help file for NetWare for SAA Services Manager commands command(<Alt> 
<H> <C>).
Related Topics
Alarms Command 
Glossary Command 
Index Command 
Overview Command 
Procedures Command 



Copy Command

Copies information displayed in a NetWare for SAA Services Manager window to the 
Microsoft Windows clipboard.
You choose Copy from the Edit menu (<Alt> <E> <C>).
Related Topics
Copying
Output window
Printing 
Saving Data to a File 
Saving Data to the Windows Clipboard 



Event Monitor Command

Opens the Event Monitor window (<Alt> <A> <E>).
Related Topic
Event Monitor Window 



Exit Command

Exits NetWare for SAA Services Manager.
You choose the Exit command from the File menu (<Alt> <F> <X>).
Related Topic
Exiting NetWare for SAA Services Manager 



Index Command

Accesses the Help file index (<Alt> <H> <I>).
Related Topics
Alarms Command 
Commands Command 
Glossary Command 
Overview Command 
Procedures Command 



Glossary Command

Accesses the Help file glossary (<Alt> <H> <G>).
Related Topics
Alarms Command 
Commands Command 
Index Command 
Overview Command 
Procedures Command 



Output Command

Opens the Output window, which allows you to print, copy, and save information 
included in NetWare for SAA Services Manager windows.
You choose Output from the File menu (<Alt> <F> <O>).
Related Topics
Copy Command 
Output Window 
Printing 
Saving Data to a File 
Saving Data to the Windows Clipboard 



Overview Command

Accesses the Help file overview of NetWare for SAA Services Manager features and 
functions (<Alt> <H> <O>).
Related Topics
Alarms Command 
Commands Command 
Glossary Command 
Index Command 
Procedures Command 



Procedures Command

Accesses the Help file for NetWare for SAA Services Manager procedures (<Alt> <H> 
<P>).
Related Topics
Alarms Command 
Commands Command 
Glossary Command 
Index Command 
Overview Command 



Tile Command
Arranges all open windows in rows and columns so that you can view them all at the 
same time.    You choose Tile from the Windows menu (<Alt> <W> <T>).
Related Topic
Arrange Icons Command 
Cascade Command 





NWSAA Services Manager Menu Bar
The NetWare for SAA Services Manager provides a Menu Bar that accesses pull-down 
menus for the following topics.
Edit Menu 
Fault Menu 
File Menu 
Help Menu 
Window Menu 



Edit Menu
The Edit menu includes the Copy command, which copies information displayed in a 
NetWare for SAA Services Manager window to the Microsoft Windows clipboard. The 
keyboard shortcut for Copy is <Alt+E+C>.
Related Topics
Copying 
Copy Command 
Saving Data to the Windows Clipboard 



Fault Menu
The Fault Menu accesses the command for opening the Event Monitor window 
<Alt+A+E>.
Related Topics
Event Monitor Command 
Event Monitor Window 



File Menu
The File menu includes the commands described in the following table:

Comman
d

Function

Output Opens the Output window, 
which you can use to print 
and save information 
included in SAA Services 
Manager windows 
<Alt+F+O>.

Exit Exits NetWare for SAA 
Services Manager 
<Alt+F+X>.

Related Topics
Exiting NetWare for SAA Services Manager 
Output Window 
Printing
Saving Data to a File
Saving Data to the Windows Clipboard 



Help Menu
The Help Menu provides access to commands to open and browse the NetWare for SAA 
Services Manager help file.
The File menu includes the commands described in the following table:

Command Function
About NetWare 
for SAA Services 
Manager

Displays product inform- 
ation as well as the 
percentage of memory 
used <Alt+H+A>.

About Help Displays Windows help 
information. <Alt+H+U>

Alarms Opens the Help file for 
alarms or event messages
<Alt+H+L>.

Commands Opens the Help file for 
commands <Alt+H+C>.

Glossary Opens the Help file 
glossary <Alt+H+G>.

Index Opens the Help file index 
<Alt+H+I>.

Overview Opens the Help file 
overview of NetWare for 
SAA Services Manager 
functions <Alt+H+O>.

Procedures Opens the Help file for 
procedures <Alt+H+P>.



Window Menu
The Window menu includes the commands described in the following table. The Window 
menu also lists the names of all open NetWare for SAA Services Manager windows. A 
check mark indicates that a window is active.

Comman
d

Function

Arrange 
Icons

Arranges the server icons of 
the Active Domain window in 
rows <Alt+W+A>.

Cascade Arranges all open windows 
one in front of the other 
<Alt+W+C>.

Close All Closes all NetWare for SAA 
Services Manager windows 
open at the time you choose 
the command. However, this 
command does not close the 
Active Domain window 
<Alt+W+L>.

Tile Arranges all open windows in 
rows and columns 
<Alt+W+T>.

Related Topics
Active Domain Window 
Application Window 
Event Monitor Window 
Server Status Window 





Add icon
Adds the selected item(s) to a list box.



Audit Trail Log icon
Opens the Audit Trail Log file.



Bind icon
Loads a communications protocol to an adapter.



Change Managed Domain icon
Opens the Change Managed Domain window. 



Clear Log icon
Removes all entries from the Event Log file. 



Server Management icon
Opens the Server Management Options window.



CSDOWN icon
Brings down the NetWare for SAA v1.2 service.



CSRESTART icon
Restarts the NetWare for SAA v1.2 service.



Customize icon
Opens the Customize Events window.



Delete icon
Removes the selected item(s) from a list box. 



Event Log icon
Opens the Event Log file.



First Page icon
Scrolls to the first page of available information. 



Graph icon
Opens the Graph Settings window.



Sessions Hardreset icon
Performs a hardreset on the selected logical unit (LU). This disconnects the user from the
selected session without terminating the assignment of the LU. A communication error is 
displayed in the Operator Information Area (OIA) on the user's workstation. The user can 
restart the session.



Last Page icon
Scrolls to the last page of available information.



Load Service icon
Loads the specified service profile.



Locked icon
Locks the selected logical unit (LU).    This prevents anyone from using the selected 
session.    Anyone using the session when you click this icon is disconnected from the 
session.



More Information icon
Opens a Detailed Information window with additional record information for event log 
and audit trail log entries or configuration information for service profiles, SNA Host Link, 
logical links, or adapters.



Next Page icon
Scrolls to the next page of available information.



Load NLM icon
Loads the specified NLM.



Unload NLM icon
Unloads the specified NLM.



Ok icon
Closes the current window and applies the specified settings. 



Pie icon
Opens the Pie Settings window.



Previous Page icon
Scrolls to the previous page of available information.



Restart Service icon
Restarts the specified service profile.



Remove Event icon
Deletes the selected event from the Event Log file.



Server Status icon 
Opens the Server Status window. 



Session icon 
Opens a Sessions window for the selected profile configuration.



Sessions Softreset icon
Performs a softreset on the selected logical unit (LU).    This disconnects the user from the
session without terminating the assignment of the LU. An SNA TERM-SELF request is sent
to the host and the user is returned to the initial log on screen. The user can restart the 
session. 



Trace Start icon
Starts a trace for all logical units (LUs) or the specified LU.



Trace Stop icon
Stops a trace for all logical units (LUs) or the specified LU.



Trace icon
Opens the Trace window for the selected logical unit (LU).



View by Icon icon
Displays server icons in the Active Domain window.



View by Name icon
Displays server names in the Active Domain window.



Unbind icon
Unloads a communications protocol from an adapter.



Unload Service icon
Unloads the specified service profile.



Unlock icon
Unlocks the specified logical unit (LU). 



Update icon
Replaces the displayed information with the most recent data. 



Users icon
Opens the User Information window. 





Log File is full
Explanation:

The NetWare Communication Executive's Event Log file is full and the oldest Event Log entry is 
overwritten by the next new entry. Each additional new entry also overwrites the oldest entry.

Default Severity:
Informational.

Action:
If the operator intend to save the old Event Log file, he/she may use NetWare for SAA Services 
Manager to reset the Event Log file.



Run Command received
Explanation:

The NetWare Communication Executive received a Run Command from a NetView host.

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Run Command response received
Explanation:

The NetWare Communication Executive executed a NetView Run Command.    A response to the 
Run Command was sent to the host.

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Run Command filter error
Explanation:

The NetView Run Command filter file SYS:\SYSTEM\COMMEXEC\NVCMDS.DB contained a 
syntax error.    Possible errors are:

1) Invalid action name.

2) Invalid resource name.

3) Invalid attributes.

4) Run Command entry syntax error.

Default Severity:
Informational.

Action:
Verify the entry in the Run Command filter file is correct. 



Communication service loaded
Explanation:

A NetWare communication service profile was loaded.

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Communication service unloaded
Explanation:

The NetWare communication service profile was unloaded.

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Security agent - open route failed
Explanation:

The NetWare Communication Executive failed to open a datagram route to a service agent. This 
could result from the following reasons:

1) Service agent did not exist.

2) Agent ID was not in ACL list.

3) Server was out of memory.

4) Agent instance did not exist.

5) User did not register with Security Agent of Communication Executive.

Default Severity:
Critical.

Action:
Check the route failure code, then contact local LAN administrator.



Security agent - unauthorized user
Explanation:

The user was denied access to a host session because the user was not included in CSCON's 
Access Control List(ACL). The user could not access the resource.

Default Severity:
Critical.

Action:
Contact the local LAN administrator to ensure the user is in the Access Control List of the 
NetWare for SAA's CSCON.



Security agent - login request failed
Explanation:

The user connection request was denied because the login failed.    Login may have failed 
because of the following reasons:

1) Illegal password was specified.

2) Login to server was disabled.

3) User did not exist in the network and security was on, or the agent did not exist.

4) No agent name existed.

5) Login was made as guest and guest was not in bindery in NetWare 3.1x.

Default Severity:
Informational.

Action:
Check login failure code, then either ensure the correct password is specified, or contact the local
LAN administrator..



Error message logged
Explanation:

A NetWare Communication Executive application generated an event.    This event was logged 
into the Event Log file.

Default Severity:
Informational.

Action:
Check the error message from the Alarm Monitor summary field for appropriate action.



Link connected
Explanation:

A link to the host was established. This event was generated from the NetWare for SAA's Data 
Link Manager(DLM).

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Link disconnected
Explanation:

A link to the host was disconnected. This event was generated from NetWare for SAA's Data Link 
Manager(DLM). 

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Session level send error
Explanation:

NetWare for SAA issued a session level send error.    Application specific error data was 
generated as a result of a SEND_ERROR, MC_SEND_ERROR, DEALLOCATE, or 
MC_DEALLOCATE. 

Default Severity:
Minor.

Action:
Because the error pertains to the application, consult the application developer or the application 
manual to determine the problem.



Session level OAF address duplication
Explanation:

NetWare for SAA received a duplicate Origin Address Field (OAF) on Destination Address Field 
(DAF).    A session activation request was received for a session that is already active.

Default Severity:
Minor.

Action:
Restart the session on which the problem occurred.



Route request failed
Explanation:

NetWare for SAA was unable to perform a route request to an LU due to an invalid LU name or 
network addressable unit (NAU).

Default Severity:
Minor.

Action:
Check the configuration parameters for the LU and restart the session.



Too many session requests
Explanation:

NetWare for SAA rejected a request to activate more sessions than configured for the specified 
LU.

Default Severity:
Minor.

Action:
If more sessions are needed, have the application issue an ATTACH_LU verb for the LU allowing 
more sessions.



No Begin Bracket bit
Explanation:

NetWare for SAA detected a Begin Bracket bit not set in Request Header (RH).    The Partner LU 
did not set the required Begin Bracket bit in the RH.

Default Severity:
Minor.

Action:
Ensure that the Partner LU software is compatible with the NetWare for SAA.    The Partner LU 
software should set the Begin Bracket in the RH.



Unexpected request
Explanation:

NetWare for SAA detected a "Request to Receive"    sent in a wrong state by the Partner LU.

Default Severity:
Minor.

Action:
Ensure the Partner LU software sends "Request to Receive" in the appropriate state as specified 
in the SNA protocol.



Unexpected BIS reply
Explanation:

NetWare for SAA received an unexpected BRACKET INITIATION STOPPED (BIS) reply.    The 
Partner LU sent NetWare for SAA a BIS reply even though NetWare for SAA never sent a BIS 
request.

Default Severity:
Minor.

Action:
Ensure that the Partner LU software sends BIS replies as specified in the SNA protocol.



Error in basic conversation
Explanation:

NetWare for SAA detected an error in the Basic Conversation protocol.    The Partner LU on a 
basic conversation violated the SNA protocol.

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Error in mapped conversation
Explanation:

NetWare for SAA detected an error in the Mapped Conversation protocol.    The Partner LU on a 
mapped conversation violated the SNA protocol.

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Bad bind response
Explanation:

A BIND response was received for a session that NetWare for SAA did not send a BIND request 
for. 

Default Severity:
Minor.

Action:
No action is necessary unless it appears that the unrequested BIND response is related to other 
network problems.



Received bad network services request or response
Explanation:

NetWare for SAA received an unsupported or unrecognized SNA Network Services (NS) request 
or response.    NetWare for SAA ignores any unsupported or unrecognized NS requests or 
response it receives.

Default Severity:
Minor.

Action:
Ensure the host sends only valid NS requests and responses.



Bad unbind request
Explanation:

NetWare for SAA received an UNBIND request with a syntax error.    The Partner LU violated the 
SNA protocol by sending an UNBIND request with invalid syntax. 

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Format error
Explanation:

NetWare for SAA received Session Control Request with a format error.    The Partner LU violated
the SNA protocol by sending a Session Control Request with a format error. 

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Unexpected unbind response
Explanation:

NetWare for SAA received an unexpected UNBIND response.    An UNBIND response was 
received for a session that NetWare for SAA did not send an UNBIND request for. 

Default Severity:
Minor.

Action:
No action is necessary unless it appears that the unrequested UNBIND response is related to 
other network problems.



Bad initialization self response
Explanation:

NetWare for SAA received an unrequested INIT-SELF response.    The host sent NetWare for 
SAA an INIT-SELF response even though NetWare for SAA never sent an INIT-SELF request. 

Default Severity:
Minor.

Action:
Ensure the host software does not send unrequested INIT-SELF response.



Bad bind request
Explanation:

NetWare for SAA received a BIND request with a syntax, state, or semantic error.    The Partner 
LU violated the SNA protocol by sending a BIND request with a syntax, state, or semantic error.

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Unexpected BIS request
Explanation:

NetWare for SAA received an unexpected BRACKET INITIATION STOPPED (BIS) request.    The 
Partner LU violated the SNA protocol by sending a BIS request in the wrong state.

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Invalid NS record
Explanation:

NetWare for SAA received an invalid Network Services (NS) record.    The host violated the SNA 
protocol by sending an invalid NS record to the NetWare for SAA.

Default Severity:
Minor.

Action:
Ensure the host software follows the SNA protocol.



Session level protocol violation
Explanation:

NetWare for SAA detected an error in Session Level protocol.    NetWare for SAA detected a 
violation of the SNA protocol causing by the Partner LU.

Default Severity:
Minor.

Action:
Ensure the partner LU software follows the SNA protocol.



Bad frame
Explanation:

NetWare for SAA Data Link control (DLC) sent an invalid transmission header or frame size.    The
SNA transmission header was either invalid or the frame size was too small to be a valid SNA 
frame.

Default Severity:
Minor.

Action:
Verify the operation and the frame size of the local and remote DLCs.    Also, verify that the 
remote system is configured for SNA.



Bracket error
Explanation:

NetWare for SAA received a Bracket error.    The Partner LU violated the SNA protocol by 
incorrectly setting the Begin Bracket indicator.

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Bad GDS variable
Explanation:

NetWare for SAA received an erroneous General Data Stream (GDS) variable from a Partner LU 
on a mapped conversation. 

Default Severity:
Minor.

Action:
Ensure the Partner LU software follows the SNA protocol.



Session security error
Explanation:

NetWare for SAA received a session level security error.    The session could not be bound 
because of the session level security error. 

Default Severity:
Minor.

Action:
Ensure the application supplies the correct LU-LU password.



Conversation security error
Explanation:

NetWare for SAA received a conversation level security error.    The conversation could not be 
bound because of the error in the conversation level security.

Default Severity:
Minor.

Action:
Allocate the conversation again, and specify the correct conversation level security information.



Link error
Explanation:

NetWare for SAA link level error occurred.    NetWare for SAA could not establish a data link with 
a host or another node. 

Default Severity:
Minor.

Action:
Check the physical connection between the local system and the remote system.    Also, verify 
that the remote system is operational.



Bad transfer MS data
Explanation:

NetWare for SAA Network Management Vector Transport (NMVT) message provided by a 
TRANSFER_MS_DATA verb was too large for the Request/Response Unit (RU) size.    Because 
the NMVT was too large for the RU size, it was not sent to the SSCP.

Default Severity:
Minor.

Action:
Reduce the size of the data being sent or increase the RU size so it is adequate.



Abnormal unbind
Explanation:

NetWare for SAA received an abnormal UNBIND.    The Partner LU abnormally terminated a 
session by sending an UNBIND. 

Default Severity:
Minor.

Action:
Determine the cause of the UNBIND and correct the condition by using the sense data included 
with the UNBIND.



Create TP error
Explanation:

NetWare for SAA detected a Transaction Program (TP) error.    The application subsystem 
Create_TP exit returned the error to the NetWare for SAA.    Therefore,    NetWare for SAA 
rejected the incoming allocate.. 

Default Severity:
Minor.

Action:
Refer to the application for the cause of the rejection.



Access password error
Explanation:

NetWare for SAA Access detected a password error.    NetWare for SAA was unable to access a 
password for the session level security, therefore a session could not be bound. 

Default Severity:
Minor.

Action:
Change the application so it provides a password to NetWare for SAA through the 
ACCESS_LU_LU_PW verb.



Abnormal termination
Explanation:

NetWare for SAA terminated itself abnormally.    The possible causes are insufficient server 
memory, in-proper installation, or configuration error.

Default Severity:
Major.

Action:
Verify that sufficient memory is available for NetWare for SAA to function, the installation was 
completed properly, and the configuration using CSCON utility was done properly. 



Host link connected
Explanation:

NetWare for SAA    established a host link using the profile requested by the user.

Default Severity:
Informational.

Action:
This message is for information only.    No action is required.



Host link disconnected
Explanation:

NetWare for SAA disconnected the host link.

Default Severity:
Informational.

Action:
Refer to the error status code and check the documentation for the cause of link disconnection. 
Take the appropriate corrective action.    If the host link was removed by unloading the profile, 
then no action is required.



Serial Number Violation
Explanation:

NetWare for SAA detected a serial number violation.    The violation was caused by running an 
unauthorized copy of NetWare for SAA on a NetWare server.    It is possible that one copy of    
NetWare for SAA was installed on two or more NetWare servers and executed simultaneously.

Default Severity:
Critical.

Action:
Unload the unauthorized copy or copies of    NetWare for SAA.



Adapter Detected a Beaconing Condition
Explanation:

Adapter detected a beaconing condition on the ring during the insertion process.

Default Severity:
Major.

Action:
Retry 30 seconds.    If the error persists, contact the local LAN administrator.



Adapter Detected Another Station with the Same Address 
Explanation:

Adapter detected another station with the same address during the installation process.

Default Severity:
Warning.

Action:
Change the adapter address or locate and remove the station with the same address.



Adapter Detected a Problem on its Lobe During Installation 
Process

Explanation:
Adapter detected a problem on its lobe during the installation process.

Default Severity:
Major.

Action:
Retry 30 seconds.    If the error persists, contact the local LAN administrator.



 Adapter Received a Remove Adapter Command 
Explanation:

Adapter received a Remove Adapter command and left the ring.

Default Severity:
Informational.

Action:
Review the link data.    If the error persists, contact the local LAN administrator.



Adapter Recieved a Remove Ring Station MAC Frame
Explanation:

Adapter received a Remove Ring Station MAC frame during the installation process.

Default Severity:
Warning.

Action:
Review the link data.    If the error persists, contact the local LAN administrator.



Wire-Fault Condition Detected on Ring
Explanation:

Wire-fault condition detected on the ring.

Default Severity:
Major.

Action:
Check your cable connections.



Adapter Left Ring as Part of Automatic Recovery Process 
Explanation:

Adapter left ring as part of the beacon automatic recovery process.

Default Severity:
Warning.

Action:
Review link data.    If the error persists, contact the local LAN administrator.



Ring Beaconing and Inoperative
Explanation:

Ring is beaconing and is inoperative.

Default Severity:
Major.

Action:
Review link data.    If the error persists, contact the local LAN administrator.



Unknown Error Detected During Insertion Process
Explanation:

Unknown error was detected during the insertion process.    The insertion process was not 
completed.

Default Severity:
Warning.

Action:
Review link data.    If the error persists, contact the local LAN administrator.



Link Disconnected: Link in Data Transfer Mode When SABME Sent
Explanation:

SABME mode requested by the remote station while data was already being sent in that mode.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Invalid Command or Response Sent by Local 
Station

Explanation:
The local station sent a command or response that is not supported by the remote station.    The 
remote station sent a frame reject.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Information Field Sent at the Wrong Time by 
Local Station

Explanation:
The local station sent an information field when it was not permitted to do so.    The remote station
sent a frame.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Frames Received from Local Station Do Not 
Match Frames Sent

Explanation:
There is a discrepancy between the number of frames the remote station received and the 
number or frames the local station sent.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Information Field Sent by Local Station Too 
Long

Explanation:
The local station sent an information field that was larger than the frame size specified on the 
remote station.

Default Severity:
Warning.

Action:
Ensure that NetWare for SAA's frame size matches the frame size specified on the remote 
station.



Link Disconnected: Invalid Command or Response Sent by Remote 
Station

Explanation:
A remote station sent a command or response that is not supported by the local station.    The 
local station sent a frame reject.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Information Field Sent at Wrong Time by 
Remote Station

Explanation:
A remote station sent an information field when it was not permitted to do so.    The local station 
sent a frame. reject.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected:    Frames Received from Remote Station Do Not 
Match Frames Sent

Explanation:
There is a discrepancy between the number of frames the local station received and the number 
of frames the remote station sent.

Default Severity:
Warning.

Action:
Wait for the communication service to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Information Field Sent by Remote Station Too 
Long

Explanation:
The remote station sent an information field that was larger than the frame size specified for 
NetWare for SAA.

Default Severity:
Warning.

Action:
Ensure NetWare for SAA frame size matches the frame size specified on the remote station.



Link Disconnected: Inactive Remote Station Warning
Explanation:

The remote station does not respond to polling because it is either down or has a connection 
problem.

Default Severity:
Warning.

Action:
Verify that the remote station is inactive.    If it is active, check the connection between the 
stations.



Link Disconnected: Disconnect Mode (DM) Sent by Remote Station
Explanation:

A remote station issued a DM, which severed the logical connection between the remote station 
and the local station.

Default Severity:
Informational.

Action:
Reactivate the remote station.    If the problem persists, contact the SNA network administrator.



Link Disconnected: SNRM Sent by Remote Station When Station 
Was in Use

Explanation:
Set Normal Response Mode (SNRM) requested by the remote station while data was already 
being sent in Normal Response Mode.

Default Severity:
Warning.

Action:
Wait for the communication services to reestablish the link.    If the problem persists, contact the 
SNA network administrator.



Link Disconnected: Receive Window Size Exceeded Because of Too 
Many Remote Station Information (I) Frames

Explanation:
A remote station sent more information (I) frames than specified by the receive window size.

Default Severity:
Warning.

Action:
Check the remote station's window size.    If necessary, reconfigure the receive window size as 
discussed in the remote station's documentation.



Link Disconnected: Inactivity Time of Local Station Expired
Explanation:

The local station did not receive anything during the period of time specified by the local station's 
inactivity timer.

Default Severity:
Warning.

Action:
Verify there is an active remote station and check the physical connections.



Link Disconnected: Exchange Station ID (IXID) Retry Limit Exceed 
on Local Station

Explanation:
The local station sent an XID, but the remote station either did not receive it or ignored it.

Default Severity:
Warning.

Action:
Verify there is an active remote station and check its physical connections.



Link Disconnected: Remote Station Rejected a Frame without 
Including Why

Explanation:
Remote station rejected a frame without including information about why it rejected the frame.

Default Severity:
Warning.

Action:
Contact the SNA network administrator.



Logical Link Connected
Explanation:

Logical link established between NetWare for SAA server and host.

Default Severity:
Informational.

Action:
No action required.



Logical Link Disconnected
Explanation:

Logical link between NetWare for SAA server and host disconnected.

Default Severity:
Informational.

Action:
No action required.



Link Disconnected: Disconnect Mode Sent by Remote Station
Explanation:

A remote station issued a DM, which severed the logical connection between the remote station 
and the local station.

Default Severity:
Informational.

Action:

Reactivate the remote station.    If the problem persists, contact the SNA network 
administrator.





 NWSAA Services Manager    Help
The following NetWare for SAA Services Manager help topics are available. Click an icon 
to get help information for that topic.

 
Alarms Help

 
Commands Help

 
Glossary Help

 
Icons Help

 
Keyboard Help

 
Overview Help

 
Procedures 
Help

 
NWSAA Services 
Manager Windows 
Help

For Help on Help, Press F1



 NWSAA Services Manager Alarms
This window lists the possible alarms you may receive while running NetWare for SAA 
Services Manager.
Abnormal Termination 
Abnormal Unbind 
Access Password Error 
Adapter Detected a Beaconing Condition 
Adapter Detected Another Station with the Same Address 
Adapter Detected a Problem on Its Lobe During the Installation Process 
Adapter Left Ring as Part of the Automatic Recovery Process 
Adapter Received a Remove Adapter Command 
Adapter Received a Remove Ring Station MAC Frame 
Bad Bind Request 
Bad Bind Response 
Bad Frame 
Bad GDS Variable 
Bad Initialization Self Response 
Bad Transfer MS Data 
Bad Unbind Request 
Bracket Error 
Communication Service Loaded 
Communication Service Unloaded 
Conversation Security Error 
Create TP Error 
Error in Basic Conversation 
Error in Mapped Conversation 
Error Message Logged 
Format Error 
Host Link Connected 
Host Link Disconnected 
HostPrint has lost contact with remote file server 
HostPrint reconnect to remote file server failed. 
HostPrint reconnect to remote file server was successful 
HostPrint Session Connect failed 
HostPrint Session Connect was successful 
Invalid NS Record 
Link Connected 



Link Disconnected 
Link Disconnected: Disconnect Mode Sent by Remote Station 
Link Disconnected: Exchange Station ID (IXID Retry Limit Exceeded on Local Station 
Link Disconnected: Frames Received from Local Station Do Not Match Frames Sent 
Link Disconnected: Frames Received from Remote Station Do Not Match Frames Sent 
Link Disconnected: Inactive Remote Station Warning 
Link Disconnected: Inactivity Time of Local Station Expired 
Link Disconnected: Information Field Sent at the Wrong Time by Local Station 
Link Disconnected: Information Field Sent at Wrong Time by Remote Station 
Link Disconnected: Information Field Sent by Local Station Too Long 
Link Disconnected: Information Field Sent by Remote Station Too Long 
Link Disconnected: Invalid Command or Response Sent by Local Station 
Link Disconnected: Invalid Command or Response Sent by Remote Station 
Link Disconnected: Link in Data Transfer Mode When SABME Sent 
Link Disconnected: Receive Window Size Exceeded Because of Too Many Remote Station 
Information Frames 
Link Disconnected: Remote Station Rejected a Frame without Including Why 
Link Disconnected: SNRM Sent by Remote Station When Station Was in Use 
Link Error 
Log File is Full 
Logical Link Connected 
Logical Link Disconnected 
No Begin Bracket Bit 
Received Bad Network Services Request or Response 
Ring Beaconing and Inoperative 
Route Request Failed 
Run Command Filter Error 
Run Command Received 
Run Command Response Received 
Security Agent - Login Request Failed 
Security Agent - Open Route Failed 
Security Agent - Unauthorized User 
Serial Number Violation 
Session Level Origin Address Field Address Duplication 
Session Level Protocol Violation 
Session Level Send Error 
Session Security Error 



Too Many Session Requests 
Unxpected Bracket Initiation Stopped (BIS) Reply 
Unexpected Bracket Initiation Stopped (BIS) Request 
Unexpected Request 
Unexpected Unbind Response 
Unknown Error Detected During Insertion Process 
Wire-Fault Condition Detected on Ring 



 NWSAA Services Manager Commands
NetWare for SAA Services Manager offers the following commands:
About NetWare for SAA Services Manager 
Alarms Command 
Arrange Icons Command 
Cascade Command 
Close All Command 
Commands Command 
Copy Command 
Event Monitor Command 
Exit Command 
Glossary Command 
Index Command 
Output Command 
Overview Command 
Procedures Command 
Tile Command 
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 NWSAA Services Manager Keyboard 
Shortcuts

The following table indicates the keyboard shortcut for each NetWare for SAA Services 
Manager command and summarizes the command functions:

Shortcut Corresponding command 
and description

Alt+A +E Fault > Event Monitor 
Opens the Event Monitor 
window.

Alt+E+C Edit > Copy 
Copies information displayed
in a NetWare for SAA 
Services Manager    window 
to the Microsoft Windows 
clipboard.

Alt+F+X File > Exit
Exits NetWare for SAA 
Services Manager.

Alt+F+O File > Output
Opens the Output window, 
which you can use to print 
and save information 
included in NetWare for SAA 
Services Manager windows.

Alt+H+A Help > About NWSAA 
Services Manager
Displays product and version
information as well as the 
percentage of memory used.

Alt+H+C Help > Commands
Accesses the Help file for 
commands.

Alt+H+I Help > Index
Accesses the Help file index.

Alt+H+L Help > Alarms
Accesses the Help file for 
NetWare for SAA Services 
Manager alarm messages. 

Alt+H+G Help > Glossary
Accesses the Help file 
glossary.

Alt+H+O Help > Overview
Accesses the Help file for an 
overview of NetWare for SAA
Services Manager functions.

Alt+H+P Help > Procedures
Accesses the Help file for 
procedures.



Alt+W+A Window > Arrange Icons
Arranges the server icons of 
the Active Domain window in
a row.

Alt+W+C Window > Cascade
Arranges all open windows in
a cascading fashion: all 
windows overlap one 
another.

Alt+W+L Window > Close All
Closes all NetWare for SAA 
Services Manager windows 
open at the time you choose 
the command. However, this
command does not close the
Active Domain window 

Alt+W+T Window > Tile
Arranges all open windows in
a tile fashion: all windows 
stacked in rows and 
columns.



 NWSAA Services Manager Overview
NetWare for SAA Services Manager allows you to monitor and manage NetWare for SAA 
services and servers over Novell LANs and WANs.    This window shows a list of the topics 
helpful to new users.
Active and Managed Domains 
Commands 
Configuration Attributes 
Display and Event Forwarding Filters 
Graphic Display of Statistical Data 
HostPrint 
Menu Bar 
NetWare for SAA Link Management 
Objects That Provide Information 
Processing of Network Events 
Severity Levels 
Severity Level Colors 
Statistical Attributes 
What is NetWare for SAA Services Manager 



 NWSAA Services Manager Procedures
This is a list of NetWare for SAA Services Manager procedures.
Accessing Additional Event Record Information 
Accessing Audit Trail Log Files 
Accessing Event Log Files Through the Event Monitor Window 
Accessing Event Log Files Through the Server Management Options Window 
Adding Servers to the Managed Domain 
Canceling Print Data 
Changing a Print Job 
Changing Server Management Options  
Clearing Event Messages 
Collecting and Displaying Statistical Data 
Controlling Sessions 
Copying 
Customizing the Display and Notification of Events 
Displaying Event Messages in Color 
Displaying Host Link Dependent Data 
Displaying the Percentage of Memory Used 
Displaying Server Icons in Color 
Displaying Session Information for LU6.2 
Exiting NetWare for SAA Services Manager 
Formatting a Print Job 
Listing Printer LU Sessions 
Loading and Unloading NLMs in v1.3 
Obtaining Configuration Data 
Loading and Unloading Protocols in v1.2 
Loading, Unloading, or Restarting Services 
Managing Printer LU Sessions 
Obtaining User Information 
Overriding Existing Connections 
Printing 
Redefining the Managed Domain 
Removing Servers from the Managed Domain 
Resetting a Printer LU Session 
Restarting or Bringing Down the Communication Executive v1.2 
Retaining Existing Connections 
Running SNA Traces 



Saving Data to a File 
Saving Data to the Windows Clipboard 
Sending a PA1 or PA2 Signal 
Setting the Audible Alert 
Setting the Critical Lock 
Setting the Display Filter 
Setting the Event Forwarding Filter 
Specifying the Number of Event Messages 
Starting HostPrint Management 
Turning Off Automatic Scrolling 
Viewing Servers By Icon 
Viewing Servers By Name 



 NWSAA Services Manager Windows
The following windows are available in NetWare for SAA Services Manager.
Access Information Window 
Active Domain Window 
Audit Trail Window 
Change Managed Domain Window 
Configuration Windows 

Adapter Configuration Window 
Logical Link Configuration Window 
Service Profile Configuration Window 
SNA Host Link Configuration Window 

Configure Printer LU Window 
Customize Events Window 
Detailed Information Windows 

Audit Trail Detailed Information Window 
Event Record Detailed Information Window 
LU 6.2 Detailed Information Window 
SNA Sessions Detailed Information Window 

Event Log Window 
Event Monitor Window 
Graph Settings Window 
Graph Statistics Window 
LU 6.2 Sessions Window 
NWSAA Services Manager Application Window 
Output Window 
Override Existing Connection Window 
Pie Settings Window 
Pie Statistics Window 
Printer LU Sessions Window 
Server Management Options Window 
Server Management Options Window v1.2 
Server Status Window 
Server Status Window v1.2 
SNA Sessions Window 
Trace Window 
User Information Window 









NetWare HostPrint Services

A service that can be installed on NetWare for SAA servers that allows applications 
running on the SAA Host to send print jobs to NetWare servers.    It does so by providing 
Printer LU sessions on the NetWare for SAA server which emulate IBM 3287 printers, 
taking print job data from applications running on the host and forwarding that data to 
print queues and servers on the LAN.    



Host Application

An application running on the host computer.    NetWare HostPrint services enables host 
applications (for example: DSPRINT, VPS, RSCS) to send print data to NetWare servers.    
In order to print on the LAN printers, the host application binds to a HostPrint Printer LU 
session and uses the NetWare print job configuration that was assigned to that session In
the NetWare CSCON utility. The host application's output to a NetWare server is governed
by the settings of that print job.    



Printer LU Session

A session on the NetWare for SAA server that is reserved for HostPrint services.    Each 
printer LU session emulates an IBM 3287 printer. Printer LU sessions are initially defined 
in the NetWare CSCON utility.



Print Job

A set of    print instructions.    In this case, a print job is a preconfigured set of instructions 
for printing output from a Host application on a LAN printer. The print job name, print 
server, and print queue are initially configured in the NetWare PRINTCON utility, the print 
job's formatting settings are defined in the SYSCON utility.



Cancel Printing icon
Cancels spooling of print data from the host.    When you click this icon, HostPrint stops 
spooling print data from the host and sends a message to the host application that the 
Cancel Printing icon has been clicked.
HostPrint resumes print spooling when the host application sends a signal to start 
printing again, either on a new body of print data or the same print data as previously, 
depending on the host application.
Depending on the print job set up, print data already spooled to Host Print may still be 
sent to the target NetWare server for printing.



Reset Print Sessions icon
Resets the current printer LU session.
Clicking this icon turns off the code in the Printer Status field and sends a power-on reset 
message to the host application.    HostPrint resumes the session when the host 
application reestablishes the session.    After the session is reestablished, printing 
continues if the host application allows it.



PA1 icon
Sends a Program Attention (PA) signal to host applications that support PA signals.



PA2 icon
Sends a Program Attention (PA) signal to host applications that support PA signals.



More Information icon
Displays the Configure Printer LU Session window for the selected printer LU session.    In 
the Configure Printer LU window, you can temporarily reconfigure settings for the 
selected printer LU session.



Start icon
Turns an operation (such as a trace or a printer LU session state) ON.



Stop icon
Turns an operation (such as a trace or printer LU session state) OFF.



HostPrint
The NWSAA Services Manager interface to NetWare HostPrint    lets you manage and 
temporarily reconfigure printer LU sessions    and associated print jobs    set up for 
NetWare HostPrint through the CSCON, SYSCON, and PRINTCON utilities. 
Within the HostPrint interface module of NWSAA Services Manager, you can select a 
HostPrint printer LU session, temporarily reassign the print job assigned to that session 
or    temporarily reconfigure the print job format settings.    You can also reset and cancel 
printing on the LU session.
The changes you make to the Printer LU session settings remain in effect until the Printer
LU Session state is turned OFF or until the HostPrint NLM is unloaded. When the HosPrint 
NLM is reloaded, the original settings are restored.
NetWare for SAA Server Prerequisites:

- NetWare for SAA v1.3 or higher installed.
- NetWare HostPrint v2.0 or later installed and loaded.
- LU sessions configured and assigned within HostPrint.
Workstation Prerequisites:

- Windows v3.1 or later installed.
- NWSAA System Manager version 2.0 or later installed.
Components

The NWSAA Services Manager interface to HostPrint consists of two windows: 
- The Printer LU Sessions Window        lists the Printer LU Sessions available on the 

target NetWare for SAA server and summarizes their attached print jobs and session 
state.    You invoke it from the Service Status window of NWSAA Services Manager. 

- The Configure Printer LU Window      displays detailed information on individual Printer 
LU Sessions and allows you to carry out limited online management and configuration
of those sessions.    You invoke it from the Printer LU Sessions window.

Related topics:
Listing Printer LU Sessions 
Managing Printer LU Sessions 



Listing Printer LU Sessions
You can list the Printer LU sessions configured on the server running NetWare HostPrint. 

1. Use NWSAA Services Manager to log in to the server running HostPrint. 
2. In the Service Status window highlight the service with the HOSTPRT service type.

If no such service is listed in the Services list box, load the service from the NLM 
Loader dialog box.

3.    In the Profile Configuration list box, highlight Printer LU Session and click on 
the Sessions Icon.

The Printer LU Sessions window appears listing the LU printer sessions and 
associated print job settings.
- If more than one screen of Printer LU Session items has been configured, click 

the First, Last, Previous, or Next icons at the top of the screen to display the 
additional screens.

- To display detailed information on, or temporarily reconfigure one of the listed 
printer LU sessions, select that session and click the More Information icon at 
the top of the screen. 

Related topics:

Printer LU Sessions Window 



Starting HostPrint    Management
If the NetWare HostPrint software is installed on a server running NetWare for SAA, you 
can manage it through the NetWare for SAA Services Manager. 

1. Use the NWSAA Services Manager to log in to the server running HostPrint .
2. In the Service Status window highlight the service with the HOSTPRT service type.

If no such service is listed in the Services list box, load the service from the NLM 
Loader dialog box.

3.    In the Profile Configurations list box, highlight Printer LU Session and click the 
Sessions icon at the top of the screen.

The Printer LU Sessions window appears listing the LU printer sessions and 
associated print job that were configured    in the CSCON utility.

Related topics:
Printer LU Sessions Window 
Listing Printer LU Sessions 
Managing Printer LU Sessions 



Managing Printer LU Sessions
The Configure Printer LU Session window allows you to manage HostPrint Printer LU 
Sessions. You can cancel print data, reset print sessions and temporarily change the Print
Job and Print Job formatting settings for a Printer LU session.    
Your setting changes remain in effect until the Printer Session State is turned OFF or until
the HostPrint NLM is unloaded.

1. Use NWSAA Services Manager to log in to the server running HostPrint.
2. In the Service Status screen highlight the service with the HOSTPRT service type.

If no such service is listed in the Services list box, load the service from the NLM 
Loader dialog box.

3.    In the Profile Configurations list box, highlight Printer LU Session and click on 
the Sessions Icon.

The Printer LU Sessions window appears displaying the LU printer sessions and 
print jobs.

4. If the Printer LU session that you want to reconfigure is not displayed in the 
current screen, click on the First, Last, Previous, or Next icons to view the 
additional screens.

5.    When you find the LU session that you want to configure, double click on that 
session.    The Configure Printer LU window for that session appears.

6. Carry out the necessary operations or changes.
Related Topics:
Configure Printer LU Sessions Window 
Formatting a Print Job 
Changing a Print Job 
Cancelling Print Data 
Resetting a Printer LU Session 
Sending a PA1 or PA2 Signal 



Formatting a Print Job
You can temporarily change the format of a configured print job in the Configure Printer 
LU window.    
The changes you make last until the next time the Printer Session State is turned OFF or 
until HostPrint    is unloaded.

1. Display the Configure Printer LU window for the Printer LU Session    whose print 
job you want to reformat. (See "Managing Printer LU Sessions" for more 
information.)

NOTE: If the printer LU session's current print job is different from the one you want 
to format, click the Stop icon to set the Printer Session State field to OFF, click on the 
Print Job Name field, click on the print job you want to reformat, and click the OK icon.
After the Configure Printer LU window for that session closes, reopen it.
2. If the Printer Session State is OFF, click the Start icon to set the Printer Session 

State field to ON.
3. Set the Chars Per Line (MPP), Lines Per Inch (LPI), and Lines Per Page (MPL) print 

settings.
4. Click the OK icon at the top of the screen to confirm your changes.

Related Topics: 
Configure Printer LU Session Window 
Managing Printer LU Sessions 
Chars Per Line field 
Lines Per Inch field 
Lines Per Page field 



Changing a Print Job
You can temporarily change the Print Job\Server\Print Queue assigned to the current 
Printer LU session .

1. Display the Configure Printer LU window for the Printer LU Session whose assigned
print job you want to change. (See "Managing Printer LU Sessions" for more 
information.)

2. If the Printer Session State field is set ON, click Stop icon to turn the session OFF.
The Print Job Name field becomes ungreyed.

3. Click on the scroll arrow in the Print Job Name field to display    a list of print jobs, 
the server where they are being run and their print queue name.    Click on the 
print job you want.    

4. Click the OK icon to confirm the new print job.
Related topics:
Configure Printer LU Window 
Managing Printer LU Sessions 
Print Job Name field 



Canceling Print Data
You can cancel print data for a Printer LU session.

1. Display the Configure Printer LU window for the Printer LU Session    whose print 
data you want to cancel. (See "Managing Printer LU Sessions" for more 
information.)

2. If the Printer Session State field is set OFF, click the Start icon to turn the session 
ON.

3. Click the Cancel Printing icon at the top of the screen.
Related Topics:
Configure Printer LU Window 
Managing Printer LU Sessions 
Cancel Printing icon 



Resetting a Printer LU Session
You can reset a Printer LU session .

1. Display the Configure Printer LU window for the Printer LU Session that you want 
to reset. (See "Managing Printer LU Sessions" for more information.)

2. If the Printer Session State field is set OFF, click the Start icon to turn the session 
ON.

3. Click the Reset Print Session icon at the top of the screen.
Clicking the Reset Print Session icon turns off any message in the Printer Status 
field and sends a power-on reset message to the host if communication has been 
established.    The session then indexes one line and printing continues if the host 
application    allows it.

Related Topics:
Configure Printer LU Window 
Managing Printer LU Sessions 
Reset Print Session icon 



Sending a PA1 or PA2 Signal
You can send a program attention, PA1 or PA2, signal to the host application    if your host
application supports such signals.

1. Display the Configure Printer LU window for the Printer LU Session    from where 
you want to send the PA1 or PA2 signal. (See "Managing Printer LU Sessions" for 
more information.)

2. If the Printer Session State field is set OFF, click the Start icon to turn the session 
ON.

3. Click the PA1 or PA2 icon at the top of the screen.
Clicking the PA1 or PA2 sends a PA1 or PA2 signal to the host application.

Related Topics:
Configure Printer LU Window 
Managing Printer LU Sessions 
PA1 icon 
PA2 icon 



Printer LU Sessions Window
The Printer LU Sessions screen:
- displays settings for the printer LU sessions    and associated print jobs    that the 

HostPrint administrator configured in the CSCON utility.
- allows users to select a printer LU session to reconfigure. 



LU Name
The LU name assigned to this HostPrint session.    Any HostPrint session used by NetWare 
HostPrint must have a dedicated LU name defined through the CSCON utility (regardless 
of whether it is an individual LU or belongs in an LU pool group).        For more information 
on LU names see the NetWare HostPrint Administration Guide.



Print Job/Server/Print Queue
This combination of Print job, server, and print queue names was defined in PRINTCON 
then assigned to a printer LU session in the CSCON utility.
Print Job - is the name of    a print job assigned to this LU session in the            CSCON 
utility.    For more information on the Print Job name the the NetWare HostPrint 
Administration Guide.
Server - is the name of the NetWare server that contains the print queue in which this 
print job will run.    This server was assigned to the print job in the PRINTCON utility.
Print Queue - is the name of the print queue in which the above print job is placed. This 
print queue was assigned to the print job in the PRINTCON utility.
    



Host Application
The name of the application running on the host that has acquired the current printer LU 
session.



Session State
The    current state of this printer LU session. Possible states are ON or OFF.



Configure Printer LU Window
The Configure Printer LU Window allows you to carry out online management and 
modification of the current Printer LU Session .



Print Job Number
The number that NetWare has assigned to the current print job.    If the server running 
HostPrint is the same as the NetWare server running the print job, then Print Job Number 
is the same number that    appears on that server's PCONSOLE display.
If the print job is being run on a different server, then the Print Job Number displayed in 
this field and on the other server's PCONSOLE will differ.
This value displays only when the print job displayed in the Print Job Name field is active.



Print Job Status
Displays whether or not HostPrint is still processing print data from the host.    The 
displayed values can be:
ADDING - indicates HostPrint is busy spooling print data to the server displayed in the 
Print Job Name field.
READY - indicates HostPrint is ready to receive and process more print data from the host
application.
These values display only when the print job displayed in the Print Job Name field is 
active.



Print Job Name
Lets you temporarily reassign and modify the Print job/Server/Print Queue combination 
assigned to this printer LU Session.    This field is active if the Printer Session State is OFF.

1. If the Printer Session State is ON, click on the Stop icon to turn the session off.
2. Click on the scroll arrow in the Print Job Name field to display    a list of print jobs, 

the server where they are being run and their print queue name.    Highlight the 
print job you want.    

3. Click the OK icon to confirm the change.
The new print job setting will remain in effect until the HostPrint NLM is unloaded.



Host Application Name
The name of the host application that is assigned to the current LU session. 



Printer Session State
Displays whether the printer session state is ON or OFF.    
- To change the Printer Session State from OFF to ON, click the Start icon at the top of 

the screen.
- To change the Printer Session State from ON to OFF, click the Stop icon at the top of 

the screen.
When the Printer Session State is ON, you are able to temporarily change the Lines Per 
Inch (LPI), Chars Per Line (MPP), and Lines Per Page (MPL) settings for the current Print 
Job.    These settings remain in effect until you change them, turn the Printer Session 
State OFF, or unload the HostPrint NLM.    You can also click the icons at the top of the 
screen to cancel the Printer LU Session, reset the Printer LU Session, or send a PA1 or PA2
signal to the the host application.
When the Printer Session State is OFF, you can change the print job/server/print queue 
combination associated with the current Printer LU session.



Printer Status
Displays printer status messages, that may apply to the current Printer LU session and 
print job.    Possible printer status messages include:

Message: Explanation:
Invalid operation. You attempted an operation that is 

not supported on your printer.
PA1 signal sent to the host 
application.

You clicked the PA1 icon.

PA2 signal sent to the host 
application.

You clicked the PA2 icon.

Press PA1 or PA2 (requested by host 
application).

Click the icon specified by your host 
administrator's instructions.

Printing cancelled. You clicked the Cancel icon.    
The target server, print queue, 
or printer is not operational.

Contact your LAN administrator.

Unexpected status indicator 
code <NN>.

Note the code number displayed, 
and contact your LAN administrator.



Lines Per Inch (LPI)
Allows you to temporarily change the print job lines per inch (LPI) setting.    This field 
appears if the Printer Session State is ON.    Permissable values are: 3, 4, 6, 8. After you 
change this setting, click the OK icon to confirm it. Any change you make to this field 
stays in effect until the Printer Session State is turned OFF or until HostPrint is unloaded. 



Chars Per Line (MPP)
Allows you to temporarily change the Characters Per Line (MPP) setting.    This field 
appears if the Printer Session State is ON.    Enter a number between 1 and 255. After you
change this setting, click the OK icon to confirm it. Any    change you make to this field 
stays in effect until the Printer Session State is turned OFF or until HostPrint is unloaded.



Lines Per Page (MPL)
Allows you to temporarily change the Lines Per Page (MPL) setting.    This field appears if 
the Printer Session State is ON.    Enter a value between 1 and 255. After you change this 
setting, click the OK icon to confirm it. Any change you make to this field stays in effect 
until the Printer Session State is turned OFF or until HostPrint is unloaded.



HostPrint has lost contact with remote file server

Explanation:

HostPrint has lost a connection to a file server on which it has a print job configured, 
probably because that file server is down.

Default Severity:

Minor
Action:

1.    Double click this message in the Event Monitor to display more Information. 
Note the server name listed.    

2.    If you have access to the listed server, restart it.    
3.    If you do not have access to the listed server, contact the LAN administrator 

who does.    HostPrint will attempt reconnection automatically every 60 seconds.



HostPrint Session Connect was successful

Explanation:

A Printer LU session was successfully reset in the CSTATUS utility by a Hard Reset 
command.    The open datagram route to the Communication Executive was 
successful.

Default Severity:

Informational
Action:

None.



HostPrint Session Connect failed.

Explanation:
A HostPrint printer LU session did not initialize    because a LAN workstation is already using the LU session 
that HostPrint is configured for.    
or
A printer LU session did not successfully reset after the Hard Reset command was used in the CSSTATUS 
utility.

Default Severity:
Minor

Action:
1.    Double click this messsage    in the Event Monitor for detailed information.    Note the LU Name listed in

the Detailed Information window. 
2.    Reload HostPrint.    Make sure no workstation is using the listed LU session.
3.    If this message persists, double click it for detailed information.    Note the listed failure code and 

contact your authorized Novell reseller.



HostPrint reconnect to remote file server failed.

Explanation:
HostPrint has lost contact with a file server and has tried and failed to reconnect to that file server.    
(HostPrint attempts to reconnect every 30 seconds.)    This message displays the first time the 
reconnection attempt fails due    to a specific error code.    Subsequent failed reconnection attempts due to 
the same condition will not display this message.    

Default Severity:
Major

Action:
1.    Double click this message in the Event Monitor to display detailed information.    Note the listed server 

name and failure code. 
2.    If you have access to the listed server, restart it.    
3.    If you do not have access to the listed server, contact the LAN administrator who does.    HostPrint will 

attempt reconnection automatically every 30 seconds.
4.    If this message persists,    double click it for detailed information.    Note the listed failure code    and 

contact your authorized Novell reseller.



HostPrint reconnect to remote file server was successful

Explanation:

After losing contact with a file server, HostPrint has successfully reconnected to that 
file server.    After losing a server connection, HostPrint attempts to reconnect every 
30 seconds.    When it succeeds, it displays this message.

Severity:

Informational
Action:

None.




